
Welcome - 1

Welcome
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MOTOROLA and the Stylised M Logo are registered in the US Patent & Trademark
Office. TrueSync, Sidekick, Starfish and the Stylised Starfish Logo are registered trade-
marks of Starfish Software, Inc., a wholly owned independent subsidiary of Motorola,
Inc. Java and all other Java-based marks are trademarks or registered trademarks of
Sun Microsystems, Inc. in the U.S. and other countries. All other product or service
names are the property of their respective owners.
© Motorola, Inc. 2003.

Software Copyright Notice
The Motorola products described in this manual may include copyrighted Motorola and
third-party software stored in semiconductor memories or other media. Laws in the
United States and other countries preserve for Motorola and third-party software
providers certain exclusive rights for copyrighted software, such as the exclusive rights
to distribute or reproduce the copyrighted software. Accordingly, any copyrighted
software contained in the Motorola products may not be modified, reverse-engineered,
distributed, or reproduced in any manner to the extent allowed by law. Furthermore, the
purchase of the Motorola products shall not be deemed to grant either directly or by
implication, estoppel, or otherwise, any licence under the copyrights, patents, or patent
applications of Motorola or any third-party software provider, except for the normal,
non-exclusive, royalty-free licence to use that arises by operation of law in the sale of a
product.
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Menu Map
• mMode
• OfficeOnline
• Calendar
• Internet Explorer
• MSN Messenger
• Inbox
• Settings

• Telephony
• Sounds
• Profiles
• Home Screen
• About
• Accessibility
• Data Connections
• Date and Time
• Owner Information
• Power Management
• Regional Settings
• Remove Programs
• Security
• Phone Settings

• ActiveSync
• Call History

• Contacts
• File Manager
• IA Album
• SIM Manager
• Speed Dial
• Tasks
• Voice Notes
• Windows Media
• Accessories

• Calculator
• Infrared Receive
• Modem Link

• Games
• Slup
• Solitaire
• Tennis Addict
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Safety and General Information
MPORTANT INFORMATION ON SAFE AND EFFICIENT OPERATION. READ THIS
INFORMATION BEFORE USING YOUR PHONE.
The information provided in this document supersedes the general safety information in
user guides published prior to December 1, 2002.

Exposure To Radio Frequency (RF) Energy
Your phone contains a transmitter and a receiver. When it is ON, it receives and trans-
mits RF energy. When you communicate with your phone, the system handling your call
controls the power level at which your phone transmits.
Your Motorola phone is designed to comply with local regulatory requirements in your
country concerning exposure of human beings to RF energy.

Operational Precautions
To assure optimal phone performance and make sure human exposure to RF energy is
within the guidelines set forth in the relevant standards, always adhere to the following
procedures.

External Antenna Care
Use only the supplied or Motorola-approved replacement antenna. Unauthorized anten-
nas, modifications, or attachments could damage the phone.
Do NOT hold the external antenna when the phone is IN USE. Holding the external
antenna affects call quality and may cause the phone to operate at a higher power level
than needed. In addition, use of unauthorized antennas may result in non-compliance
with the local regulatory requirements in your country.

Phone Operation
When placing or receiving a phone call, hold your phone as you would a wireline tele-
phone.
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Body-Worn Operation
To maintain compliance with RF energy exposure guidelines, if you wear a phone on
your body when transmitting, always place the phone in a Motorola-supplied or
approved clip, holder, holster, case, or body harness for this phone, if available. Use of
accessories not approved by Motorola may exceed RF energy exposure guidelines. If
you do not use one of the body-worn accessories approved or supplied by Motorola,
and are not using the phone held in the normal use position, ensure the phone and its
antenna are at least 1 inch (2.5 centimeters) from your body when transmitting.

Data Operation
When using any data feature of the phone, with or without an accessory cable, position
the phone and its antenna at least 1 inch (2.5 centimeters) from your body.

Approved Accessories
Use of accessories not approved by Motorola, including but not limited to batteries and
antenna, may cause your phone to exceed RF energy exposure guidelines. For a list of
approved Motorola accessories, visit our website at www.Motorola.com.

RF Energy Interference/Compatibility
Note: Nearly every electronic device is susceptible to RF energy interference from
external sources if inadequately shielded, designed, or otherwise configured for RF
energy compatibility. In some circumstances your phone may cause interference.

Facilities
Turn off your phone in any facility where posted notices instruct you to do so. These
facilities may include hospitals or health care facilities that may be using equipment that
is sensitive to external RF energy.

Aircraft
When instructed to do so, turn off your phone when on board an aircraft. Any use of a
phone must be in accordance with applicable regulations per airline crew instructions.
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Medical Devices

Pacemakers
Pacemaker manufacturers recommend that a minimum separation of 6inches
(15 centimeters) be maintained between a handheld wireless phone and a pacemaker.
• ALWAYS keep the phone more than 6 inches (15 centimeters) from your pacemaker

when the phone is turned ON.
• NOT carry the phone in the breast pocket.
• Use the ear opposite the pacemaker to minimize the potential for interference.
• Turn OFF the phone immediately if you have any reason to suspect that interference

is taking place.

Hearing Aids
Some digital wireless phones may interfere with some hearing aids. In the event of
such interference, you may want to consult your hearing aid manufacturer to discuss
alternatives.

Other Medical Devices
If you use any other personal medical device, consult the manufacturer of your device
to determine if it is adequately shielded from RF energy.Your physician may be able to
assist you in obtaining this information.

Use While Driving
Check the laws and regulations on the use of phones in the area where you drive.
Always obey them.

When using your phone while driving, please:
• Give full attention to driving and to the road.
• Use hands-free operation, if available.
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• Pull off the road and park before making or answering a call if driving conditions so
require.

Responsible driving best practices may be found in the “Wireless Phone Safety Tips” at
the end of this manual and at the Motorola website: www.Motorola.com/callsmart.

Operational Warnings
For Vehicles With an Air Bag
Do not place a phone in the area over an air bag or in the air bag deployment area. Air
bags inflate with great force. If a phone is placed in the air bag deployment area and the
air bag inflates, the phone may be propelled with great force and cause serious injury to
occupants of the vehicle.

Potentially Explosive Atmospheres
Turn off your phone prior to entering any area with a potentially explosive atmosphere,
unless it is a phone type especially qualified for use in such areas and certified as
“Intrinsically Safe.” Do not remove, install, or charge batteries in such areas. Sparks in a
potentially explosive atmosphere can cause an explosion or fire resulting in bodily injury
or even death.
Note: Note: The areas with potentially explosive atmospheres referred to above 
include fueling areas such as below decks on boats, fuel or chemical transfer or storage 
facilities, areas where the air contains chemicals or particles, such as grain, dust, or 
metal powders. Areas with potentially explosive atmospheres are often but not always 
posted.

Blasting Caps and Areas
To avoid possible interference with blasting operations, turn OFF your phone when you
are near electrical blasting caps, in a blasting area, or in areas posted “Turn off elec-
tronic devices.” Obey all signs and instructions.
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Batteries
Batteries can cause property damage and/or bodily injury such as burns if a conductive
material such as jewelry, keys, or beaded chains touch exposed terminals. The conduc-
tive material may complete an electrical circuit (short circuit) and become quite hot.
Exercise care in handling any charged battery, particularly when placing it inside a
pocket, purse, or other container with metal objects. Use only Motorola original bat-
teries and chargers.
Your battery or phone may contain symbols, defined as follows:

Seizures/Blackouts
Some people may be susceptible to epileptic seizures or blackouts when exposed to
blinking lights, such as when watching television or playing video games. These sei-
zures or blackouts may occur even if a person never had a previous seizure or black-
out.

Symbol Definition
Important safety information will follow.

Your battery or phone should not be disposed of in a
fire.

Your battery or phone may require recycling in accord-
ance with local laws. Contact your local regulatory
authorities for more information.

Your battery or phone should not be thrown in the trash.

Your phone contains an internal lithium ion battery.LiIon BATT
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If you have experienced seizures or blackouts, or if you have a family history of such
occurrences, please consult with your doctor before playing video games on your
phone or enabling a blinking-lights feature on your phone. (The blinking-light feature is
not available on all products.)
Parents should monitor their children's use of video game or other features that incor-
porate blinking lights on the phones. All persons should discontinue use and consult a
doctor if any of the following symptoms occur: convulsion, eye or muscle twitching, loss
of awareness, involuntary movements, or disorientation.

To limit the likelihood of such symptoms, please take the following safety precautions:
• Do not play or use a blinking-lights feature if you are tired or need sleep.
• Take a minimum of a 15-minute break hourly.
• Play in a room in which all lights are on.
• Play at the farthest distance possible from the screen.

Repetitive Motion Injuries
When you play games on your phone, you may experience occasional discomfort in
your hands, arms, shoulders, neck, or other parts of your body. Follow these instruc-
tions to avoid problems such as tendonitis, carpal tunnel syndrome, or other muscu-
loskeletal disorders:
• Take a minimum 15-minute break every hour of game playing.
• If your hands, wrists, or arms become tired or sore while playing, stop and rest for

several hours before playing again.
• If you continue to have sore hands, wrists, or arms during or after play, stop playing

and see a doctor.
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Getting Started
Congratulations on the purchase of your new Windows Powered Smartphone! This
chapter will help you set up your Smartphone, charge the Smartphone's batteries, and
familiarise yourself with the different components of your Smartphone. You will also find
information about installing Microsoft ActiveSync, and where you can find additional
help for using your Smartphone.

Package Contents
Check the contents of the package. The following items should be included. If there is
any item damaged or missing, please contact your dealer immediately.

Optional Features
This label identifies an optional network, SIM card, or
subscription-dependent feature that may not be offered by all service
providers in all geographical areas. Contact your service provider for more
information.

Optional Accessories
This label identifies a feature that requires an optional Motorola OriginalTM

accessory.

Description Quantity
GSM/GPRS Smartphone 1
Earphone (with remote controller) 1
Switching charger 1
USB data cable 1
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Setting up your Smartphone
Installing the SIM card 

The SIM (Subscriber Identification Module) card is a small plastic card with metal
contact on it. You get this card after you subscribe to your operator.Your personal
subscriber information is stored in this card and you need to use it in the phone to
make/receive calls and access services provided by your operator.

What is a SIM card?

Make the back side of the phone face
upward and open the battery cover as
shown.

Lift the battery up from the bottom end
and remove it from the phone.
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• Insert the SIM card into the socket with
the metal�

��

� contact on the card facing
down and the bevelled corner in the
direction shown.

• Push the SIM card fully into the socket.

The bevelled corner

SIM card socket

Slide the SIM card retainer in the
direction shown and make sure the
retainer goes on top of the SIM card to
secure the SIM card.

SIM card
retainer
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Installing and charging the battery

Installing the battery
Your phone is designed for use only with Motorola Original batteries and accessories.
We recommend that you store batteries in their protective cases when not in use.

Place the battery onto the back of
the phone, with the contacts on
the top end of the battery in
alignment with the contacts on
the phone.

Push the bottom end of the battery into
the phone until it clicks into the
compartment.
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Place the battery cover back on the phone.
Align the tabs on the cover to the groove
on the phone.

Slide the battery cover in the direction
shown until it locks into place.
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Charging the battery

Notes: 
•  Charge the new battery before first time use. When the battery is being charged, the

bars of the charging status icon on phone external display scrolls. When charging is
completed, the bars will stop scrolling. You can use the phone during the charging
process. However, it will take longer to fully charge the battery.

Open the sync/charger
socket cover.

Plug battery charger connector into the
sync/charger socket.
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•  When battery power is low, a low battery message will pop up on the display. Charge
the battery immediately.

•  If battery power is completely drained, the phone will be turned off automatically.
•  When charging a completely drained battery, it will take longer for the charging status

icon to appear on phone external display.

Getting to know your Smartphone

Function Buttons

Name Description

Power button

• Pressing the Power button turns the Smartphone on.

• When the Smartphone is on, pressing the Power button
accesses the Quick List.

• Pressing and holding the Power button turns the Smartphone off.

Jog dial

When phone flip is open/closed:
• Controls the volume of the earpiece, speaker and headset.

When receive an incoming call:
• Mute the ring.

• Reject the call when phone flip is closed.

When an incoming is connected:
• Controls the volume of the earpiece, speaker and headset.

When phone flip is open:
• Records voice notes.

Soft key Performs the command shown on the screen immediately above
the key.
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Keypad
Used to enter numbers and characters.

Asterisk key (*)
Pressing the Asterisk key changes between upper and lower case in text input mode.
Pressing and holding the Asterisk key changes between text and numeric input modes.

Talk button

• Dials a phone number you entered using the keypad.

• Dials a phone number you selected from the Call History list.

• Answers an incoming call.

• Places a call on hold to answer a second incoming call (call
waiting).

• Changes between an active call and a call that is on hold.

• Activates the speaker phone.

End button
• Ends active data calls at any time.

• Ends a call when one party is on the line, and ends the active call
when multiple parties are connected.

Home button Displays the Home screen and Quick List.

Back button Navigates to the previous screen, or backspaces over one or more
characters when you are in a text field.

Action button
Confirms your selection. The Action button's functionality is similar
to pressing "Enter" on a keyboard, and is sometimes referred to as
the "Do It" button.

Direction key Move the selection focus up, down, left, or right, and move the cur-
sor left or right in text fields.
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Pound key (#)
Pressing and holding the Pound key displays a list of symbols.

Display
External display

The following table lists the icons that are displayed on the external display and their
meanings.

Icon Meaning Icon Meaning
Signal strength Battery level

Call in progress Battery low

Data call active No battery

No signal Charging

Radio off Ringer off
You have unread new mes-
sage(s) Speaker

You have missed call(s) GPRS in use

Call forwarding Roaming

New instant message

Signal strengthBattery level
Current time

Current date
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The display shown may be different based on the specific external LCD Style chosen.
See "Phone Settings" on page 62.

Main display
• The screen on the Smartphone that displays information.
• The top of the display shows status indicators about the Smartphone's current mode,

or the name of the current activity or active program.
• The center of the display shows the Home screen, as well as e-mail messages, con-

tacts, appointments, and other types of information.
• The bottom of the display shows the soft key commands.

Home screen
• Displays the five programs you have most recently used, the name of your service

provider, the current time, your next appointment, the number of messages in Inbox,
and your current profile.

Note: The display shown may be different based on the specific Home screen configu-
ration chosen.

Your current service
provider

Number of unread
messages

Your current profile

Select and press the
Action button to access
your most recently-used
programs

Next appointment

Number of missed
calls
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Status indicators
Status indicators are displayed at the top of the Smartphone's display. The following
table lists common status indicators and their meanings.

Indicator Meaning Indicator Meaning
New e-mail No signal

New voice mail GPRS available

New instant message GPRS in use

Voice call active Roaming

Data call active Sync error

Call forwarding Radio off

Call on hold Ringer off

Missed call Speaker

Line 1 Multipress text input mode, low-
ercase

Line 2 Multipress text input mode,
uppercase

Battery level Multipress text input mode,
caps lock

Low battery T9 text input mode, lowercase

Battery charging T9 text input mode, uppercase

No battery T9 text input mode, caps lock

Signal strength Numeric input mode
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Earpiece & Speaker
The audio components of the Smartphone.You can hear the voice during a call by the
earpiece, and the ringtone and the windows media files will be played by the speaker.
You can also toggle between the earpiece and speaker during a call. See
"Miscellaneous call tasks" on page 45 for details.

Jog dial
You can use the jog dial to adjust earphone/speaker/headset volume.

Infrared port
With the infrared port, you can perform sync and exchange files with a PC or other
mobile devices wirelessly.

Headset socket
The headset can be plugged into this socket for hands-free operation.

Increase volume

Decrease volume

Record voice notes
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Memory card slot
An MMC memory card can be inserted into this slot to further expand data storage
capability of your phone.

Handstrap hole
You can install a handstrap using this hole.

Synchronising with ActiveSync
You can use Microsoft ActiveSync technology to synchronise information on your
desktop computer and/or a Microsoft Exchange Server with the information on the
Smartphone. ActiveSync compares the information on the Smartphone with the
information on the desktop computer and/or the server and updates all locations,
keeping you up-to-date with the most recent information.
Note: You can synchronise information directly with a Microsoft Exchange Server if 
your�

��

�company is running Microsoft Mobile Information Server 2002 or later.

Installing ActiveSync
ActiveSync is already installed on the Smartphone.
Note: Make sure to install ActiveSync 3.6 or above on your desktop computer before 
connecting the Smartphone to the desktop computer. ActiveSync can be downloaded to 
your desktop computer for free from the website of Microsoft.

Headset
socketMemory card

slot
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After the first synchronisation, take a look at Calendar, Contacts, and Tasks on the
Smartphone. You will notice that your information has been copied to the Smartphone.
Disconnect the Smartphone from the desktop computer and you are ready to go!
For more information about ActiveSync, see "Beaming information" on page 93.

Where to find information
The following table is a guide to finding information to help you use the Smartphone.

Information about Source
Making a phone call Smartphone User's Guide: "Making a call" on page 39.
Programs on the
Smartphone Smartphone User's Guide

Additional programs that
can be installed on the
Smartphone

Smartphone Companion CD

Connecting to and
synchronising with a
desktop computer and/or a
Microsoft Exchange Server

ActiveSync Help on your desktop computer

Text entry Smartphone User's Guide or Smartphone Quick
Reference Card

Smartphone How-To
information on the Web Smartphone Pocket Internet Explorer Favorites list

Last-minute updates and
detailed technical
information

Readme files, located in the Microsoft ActiveSync folder
on the desktop computer.

Up-to-date information on
your Smartphone http://www.microsoft.com/mobile
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The Basics
This chapter explains basic information about using the Smartphone, such as
navigating around the Smartphone, entering text and numbers on the Smartphone, and
securing the Smartphone.

Navigation methods
The following information describes the different methods for navigating around the
Smartphone so you can accomplish tasks quickly and easily.

Using the Direction key
The Direction key is used to navigate horizontally and vertically on the screen to move
the selection focus, so you can select the item you want. When you see instructional
text about selecting an item, use the Direction key to make your selection.
The following table shows the four different actions you can perform with the Direction
key, and how it helps you navigate on the screen.

Direction key
action

Navigation

Press Up Moves the selection focus upward on the screen.
Press Down Moves the selection focus downward on the screen.

Press Right
Moves the selection focus forward on the screen, or
moves the cursor forward through characters in a text
field.

Press Left
Moves the selection focus backward on the screen, or
moves the cursor backward through characters in a text
field, without deleting characters.
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Using the Action button
The Action button confirms your selection. You can think of the Action button as the "Do
It" button. In some cases, confirming your selection will take you to a program or set-
ting.

Using the Home button
The Home button takes you to the Home screen.

Using the Home screen
• The Home screen is your starting place for most tasks. You can easily navigate to any

program or setting on the Smartphone from this screen. The top of the Home screen
displays the five programs you have most recently used. Just select a program and
press the Action button to open the program. You can also press the Programs soft
key to enter the programs list. The Home screen also displays the current time, your
next appointment, the number of messages in Inbox, and your current profile.

• Selecting your next appointment and pressing the Action button to open Calendar,
you can see all of your appointments for the day. To view Inbox, just select the e-mail
status showing the number of messages you have, and press the Action button. To
view Contacts, press the Contacts soft key.

• The Home screen automatically displays when you turn the Smartphone on or leave
the Smartphone idle when it is on, but you can navigate to it at any time by pressing
the Home button.
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Note: The display shown may be different based on the specific Home screen 
configuration chosen.

To access the Home screen
• Press the Home button.

To change Home screen settings
• See "Home screen" on page 57.

Navigation options from the Home screen
• Select a recently-used program at the top of the screen, and then press the Action

button to open the program.
• Select an item in the center of the Home screen, such as your next appointment, your

e-mail/SMS information, or your profile type, and then press the Action button to open
the program or access the settings associated with the item selected.

• Press the Programs soft key to display the list of programs available on the
Smartphone, select a program, and then press the Action button.

Your current service
provider

Number of unread
messages

Your current profile

Select and press the
Action button to access
your most recently-used
programs

Next appointment

Number of missed
calls
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• Press the Contacts soft key to display the Contacts list, select a contact, and then
press the Action button.

Using the Back button
Pressing the Back button navigates to the previous screen, or moves the cursor back to
delete one or more characters in a text field, similar to pressing "Backspace" on a key-
board.

To backspace and remove one character in a text field
• Press the Back button.

To backspace and remove multiple characters in a text field
• Press and hold the Back button.

Using soft keys
There are two soft keys on the Smartphone, located directly below the display screen.
Each soft key performs the command displayed immediately above it on the screen,
making it easy to navigate around the Smartphone and to perform common commands.

Using menus
On many screens, the right soft key is labelled Menu. The Menu soft key displays a list
of menu options that are relevant to the screen you are viewing. Selecting a menu



The Basics - 31

option will either perform the command or take you to another part of the user interface
where you can perform the command.

To access menu options
1. Press the Menu soft key on any screen where it is displayed.
2. Select a menu option and press the Action button.
Note: Pressing Up moves the selection focus to the bottom of the menu.

Using the Programs list
The Smartphone comes pre-installed with many programs that you can start using. To
install additional programs on the Smartphone, refer to the Smartphone Companion CD
that came with the Smartphone. If the Smartphone provides a SIM toolkit to access pro-
grams on the SIM card, the toolkit is added to Programs.

To navigate to a program
1. On the Home screen, press the Programs soft key.
2. Select a program and press the Action button.

Press the Menu softkey
to display menu options
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Using numbers
You can also use numbers to navigate quickly to programs and settings on the Smart-
phone. Just press the number on the keypad that corresponds to the number shown
next to the program or setting you want.
For example, in Programs, press 3 on the keypad to open Calendar.
Note: You can also use numbers to select menu options by pressing the number that 
corresponds to the menu option in top-down order. For example, if you want to select 
Filter in the list of Contacts menu options, you can press 4 on the keypad because the 
Filter option is fourth in the list.

Using the Quick List
The Quick List displays a list of commands, such as locking the Smartphone, locking
the Smartphone's keypad, turning off the radio, and the list of available profile types.

To access the Quick List
• Press the Power button, or press and hold the Home key.

Entering text and numbers on your Smartphone
You can enter text and numbers on the Smartphone using the keypad. The Smartphone
supports three input modes for entering text and numbers: Multipress, T9, and
Numeric. The Multipress and T9 modes are used for entering text, and the Numeric
mode is used for entering numbers. When you select a field that requires text or
numeric entry, the Smartphone will automatically default to the appropriate input mode.
The status indicator on the top of the display shows the input mode you are currently
using.

To change input modes
• Press and hold the Asterisk (*) key until the status indicator for the input mode you

want is shown on the top of the display.
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The following table shows the complete list of input mode status indicators.

Entering text in Multipress mode
When you are in Multipress mode, you can enter a letter by pressing the number key on
which the letter appears. To enter the first letter on the number key, press the key once.
To enter the second letter, press the key twice, and so on. The letter entered most
recently is underlined until you have completed the keypresses for the letter and moved
on to the next letter.
For example:
• To enter the letter "s," press 7777.
• To enter the word "hat," press 44, 2, 8.
When you enter letters that are on the same number key, you must pause after entering
the first letter and wait until the underline disappears before entering the next letter so
that your Smartphone can process the first letter. This pause is called the Multipress
time out, and you can adjust the length of the pause between keypresses.
For example:
• To enter the word "cat," press 222, pause, press 2, and then press 8.

Indicator Mode
Multipress text input mode, lower case

Multipress text input mode, upper case

Multipress text input mode, caps lock

T9 text input mode, lower case

T9 text input mode, upper case

T9 text input mode, caps lock

Numeric input mode
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To change the Multipress time out
1. On the Home screen, press the Programs soft key, select Settings, and then select

Accessibility.
2. Under Multipress time out, select the time interval you want for the pause between

keypresses, and press the Done soft key.

To enter punctuation in Multipress mode
• Press 1 repetitively to scroll through common punctuation.

Entering text in T9 mode
When you are in T9 mode, just press the number keys that contain the letters you want
to form a word. T9 will then analyse your keypresses and attempt to complete the word.
For example:
• To enter the word "shoe", press 7, 4, 6, 3.

To enter text using T9 mode
1. Press and hold the Asterisk (*) key until the T9 indicator appears on the top of the

display.
2. Enter the numerical sequence that represents the word you want to enter.
3. Press the Pound (#) key to accept the word and enter a space after it, or press 0 to

scroll through the available words.
4. If you do not see the correct word, erase the word, and then press and hold the

Asterisk (*) key to change to Multipress mode, and manually enter the word.

Having trouble entering a word in T9 mode?
T9 cannot always find the word you want in the T9 dictionary; in these cases, change to
Multipress mode. After you have entered the word in Multipress mode, the word will be
added to the T9 dictionary.
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To enter punctuation in T9 mode
• Press 1, then 0 to scroll through common punctuation.

Entering numbers in Numeric mode
When you are in Numeric mode, just press the number(s) you want to enter on the
keypad. If a field permits a numerical entry only, such as the Work phone field in
Contacts, the input mode will automatically default to Numeric mode.

Miscellaneous input tasks

To enter a space
• In Multipress or T9 mode, press the Pound (#) key on the keypad.

To start a new line
• Press the Action button.

To change between uppercase and lowercase in text mode
• Press the Asterisk (*) key to change between uppercase and lowercase.
Note: When you are in text mode, the first letter of a sentence is automatically 
capitalised.

To lock caps
• Press the Asterisk (*) key twice. Press the Asterisk (*) key again to return to

lowercase.

To enter a symbol
• Press and hold the Pound (#) key, select a symbol, and then press the Done soft key.

To enter a number, an asterisk (*), or a pound sign (#)
• Change to Numeric mode, and press the corresponding key on the keypad.
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To delete characters
1. Press the Back button to backspace over a single character.
2. Press and hold the Back button to backspace and delete an entire text field.

To enter the plus (+) sign for international calls
• Press and hold 0.

Securing your Smartphone
You can customise the level of security you want to have on the Smartphone by locking
the keypad, the entire Smartphone, or the SIM card.

Locking the keypad
The keypad lock turns off the keypad functionality. This is a helpful feature if, for
example, the Smartphone is turned on and in your pocket, and you want to prevent
accidental keypresses.

To lock your keypad
• On the Home screen, press and hold the End button. The left soft key will display

Unlock, indicating that the Smartphone is locked.

To unlock the keypad
• On the Home screen, press the Unlock soft key, and press the Pound (#) key.
Note: You can still receive calls and make emergency calls when the keypad is locked.

Locking the Smartphone
Locking the Smartphone prevents access to personal data. When you enable this fea-
ture, the Smartphone will automatically lock after a specified time of inactivity. A screen
will be displayed requiring your Smartphone lock password before access is granted.
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Note: You can still receive calls and make emergency calls when the Smartphone is 
locked.

To lock the Smartphone
1. Press the Power button to display the Quick List, select Device lock, and then press

the OK soft key.
2. Under Lock phone after, select a desired time period the Smartphone is inactive

before the Smartphone automatically locks.
3. Under Password, enter the password you want to use to access the Smartphone

when it is locked.
4. Under Confirm password, enter the password again, and press the Done soft key.
Note: After you have selected the time delay and created a password, you can then 
quickly lock your Smartphone from the Quick List, without having to view these settings.

To unlock your Smartphone
• Press the Unlock soft key, enter your password, and then press the Unlock soft key

again.

To turn off phone lock
• On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Security, select Disable Phone Lock, and then press the Done
soft key.

Locking the Subscriber Identity Module (SIM) card
Locking the SIM card prevents you and others from using the Smartphone that contains
the SIM card until the correct password is entered.You can still make emergency calls
when the SIM card is locked.
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To lock the SIM card
1. On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Security, select Enable SIM Lock, and then press the Done soft
key.

2. Enter your PIN1 password, and press the Done soft key.

To unlock the SIM card
1. On the Home screen, press Programs, select More, select Settings, select More,

select Security, select Disable SIM Lock, and then press the Action button.
2. Enter your PIN1 password, and press the Done soft key.
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Phone Calls
This chapter explains how to make and receive phone calls, view Call History, and
create shortcuts to help you manage calls more efficiently.

Making a call
There are several ways to make a call. The easiest way is to simply dial a phone
number from the Home screen.

To make a call
• On the Home screen, press the numbers on the keypad to enter the phone number,

and then press the Talk button.

To make a call by entering a contact name
1. On the Home screen, press the keys on the keypad to spell the contact name.
2. When you see the contact name displayed, select it, and press the Talk button.
Note: As you enter a phone number or contact name, the Smartphone searches 
Contacts, Call History, Speed Dial lists, and the Subscriber Identity Module (SIM) card 
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to find a matching name and/or number. When you see the name of the person to call 
listed, select it, and press the Talk button. 

Making a call from Contacts
To call someone from the Contacts list, just select the person's name, and press the 
Talk button.
If you have more than one phone number for a contact, such as a Work phone number,
a Home phone number, and a Fax number, the Work phone number is set as the
default number. Pressing the Talk button will always dial the default number, but you
can change the default number at any time.

To make a call by contact name
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact name to call, and press the Talk button.
Note: If you have a long list of contacts and you don't see the contact you want on the 
screen, you can enter the first few letters of the contact's name, and the Smartphone 
will search through the entire Contacts list and display the name.

AutoFilter matches number to
a contact

AutoFilter matches number
from Call History
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To change the default number for a contact
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact, and press Left or Right to change the default number.
3. For example: If you change "w" to "m," the default number changes from Work phone

(w) to Mobile phone (m).
Note: For more information about contact list abbreviations, see "Contacts, Calendar 
and Tasks" on page 79.

To make a call from an open contact
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to call, and press the Action button.
3. Select the number you want to call, and press the Talk button.

Making a call using a recently-dialled number
You can display a list of phone numbers you have recently dialled and choose a name
or number from the list to call the person again.

To make a call using a recently-dialled phone number
1. On the Home screen, press the Talk button to display a list of recently-dialled phone

numbers.
2. Select the number or name for the person to call, and press the Talk button again.

Making a call from the Call History list
The Call History list displays the last 25 calls you made, received, and missed. Choose
a name or number to call someone from the list.
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To make a call from the Call History list
1. On the Home screen, press the Programs soft key, select Call History, and then

press the Action button.
2. Select the number or entry for the person to call, and press the Talk button.

Making a call from a hyperlink
When you see an underlined phone number presented as a hyperlink in an e-mail
message, just select the hyperlink phone number, and press the Action button to make
the call.

Making emergency calls
Calls to emergency service numbers can be made under any circumstances, even if
you have locked the SIM card and/or the Smartphone.

To place an emergency call
• On the Home screen, dial the emergency number appropriate for your location, and

press the Talk button.

Having problems making a call?
Check to make sure that the Smartphone contains a valid SIM card and that the
Smartphone is turned on, unlocked, and in the service area of the selected service
provider's network.

Receiving a call
You can answer a call by pressing theTalk  button or the Accept soft key. If you don't
want to take the call, press the Reject soft key.
Note: There may be situations where you want to immediately silence the ring of an 
incoming call. Simply press the Volume control, and then proceed to answer the call.
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To answer an incoming call
• When phone flip is closed, simply open the flip to answer the call. To use this function,

you have to activate the flip answer function first(see "Phone Settings" on page 62).
• When phone flip is open, press the Talk button or the Accept soft key to answer the

call.

To reject an incoming call
• When phone flip is closed, quickly press the jog dial two times to reject the call.
• When phone flip is open, press the End button or the Reject soft key.
When you receive a call, the name and number of the caller are displayed on the
screen. If the name of the caller is not in your Contacts list, only the caller's phone
number will be displayed.

Note: You can use earphone to receive/reject an incoming call when phone flip is 
closed.  Press the button on the remote controller once to answer the call, press again 
to reject the call.

Caller ID informa-
tion is matched to

a contact

Phone number is
identified as
Work number in
Contacts
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To answer a second call using Call Waiting
• If you are already talking on the Smartphone when you receive a call, press the

Accept soft key or the Talk button to place the first call on hold, and answer the sec-
ond call.

• If you want to end the first call before answering the incoming call, press the End but-
ton, and then press the Accept soft key or the Talk button to accept the incoming call.

Note: Call Waiting is available only if you have subscribed to this service. Check with 
your service provider.

To reject a Call Waiting call
• If you are already talking on the Smartphone when you receive a call and you don't

want to answer it, press the Reject soft key. This will keep your current call in
progress, but will reject the Call Waiting call.

In-call options
While a call is in progress, you can press the Menu soft key to access menu options for
common tasks.
The following table shows the menu options available when a call is in progress. Some
of these options are available only when multiple calls are in progress or during a
conference call.

Menu Option Function
End Disconnects the call.
Hold Places the active call on hold.

Unhold Activates the call on hold.
Swap Changes between two calls.

Save Contact Creates a contact for the caller.
Conference Joins together all existing calls, if you have subscribed to this service.
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Miscellaneous call tasks

To place a call on hold
• Press the Hold soft key.

To change between two calls
• Press the Swap soft key.

To end a call
• Press the End button to disconnect.

To redial the last number called
• On the Home screen, press the Talk button twice.

To listen to a voice-mail message
1. On the Home screen, press and hold 1 to automatically call the voice-mail system.
Note: You can also access voice-mail messages from Inbox. Just select the voice-mail 
message, and press the Voice Mail soft key or the Talk button to call the voice-mail 
system.
2. On the Home screen, press the Programs soft key. Select Inbox/SMS, and press

the Action button.
3. Select the voice-mail message and press the Voice Mail soft key or the Talk button.

Your voice mail system is then called.

Private
Breaks one call out of a conference and makes this call active while
the rest of the conference is on hold.

Mute
Mutes the microphone for the active call. The other party will not hear
anything you say, but you can still hear the other party.

Unmute Turns the microphone back on for the active call.
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To change between the earpiece and the speaker 
• During an incoming call, you can toggle between the earpiece and speakerphone by

holding down the Talk button.

Reviewing your calls
Using Call History and Call Timers, you can view information about phone calls you
have made and received, such as who has called you recently and how much time you
have spent on the Smartphone.

Call History
Call History displays the last 25 calls you have made, received, and missed. Each entry
in Call History contains the start time of the call, the duration, the caller's name, if
available, and the caller's number. The oldest calls are automatically deleted from the
list to make room for the newest calls.

To view Call History
• On the Home screen, press Programs, select Call History, and then press the

Action button.
Note: You can filter Missed Calls, Incoming Calls, and Outgoing Calls. Press the Menu 
soft key, select Filter, press the Action button, and select the filter you want.

To view contact information from Call History
• Select the entry for the contact, press the Menu soft key, select Find Contact, and

then press the Action button.

To send an e-mail message from Call History
• Select the contact, press the Menu soft key, select E-mail, and then press the Action

button.
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To create a new contact from a number in Call History
• Select the entry, press the Menu soft key, select Save, and then press the Action but-

ton. Make sure <New Item> is highlighted and then press Done to enter the contact
information.

To remove an item from Call History
• Select the item, press the Menu soft key, select Delete, and then press the Action

button.

To remove all items in Call History
• Press the Menu soft key, select Delete List, and then press the Action button.

Call Timers
Call Timers contains detailed information regarding the length of your last call, the total
number of calls made and received, calls by type (incoming, outgoing, roaming, and
data), and a lifetime counter. Call Timers is useful when you want to keep track of your
calling patterns, for example to determine what type of calling plan to subscribe to or to
help you estimate your monthly billing.

To view Call Timers
• On the Home screen, press the Programs soft key, select Call History, press the

Menu soft key, select View Timers, and then press the Action button.
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To reset Call Timers
• On the Home screen, press the Programs soft key, select Call History, press the

Menu soft key, select View Timers, and then press the Action button.
• Press Menu and press Action button to reset all timers.
Note: The Lifttime timers can not be reset.

Shortcuts
You can create speed dials and voice tags as shortcuts to dial frequently-dialled phone
numbers quickly.

Speed dials
You can create speed dials to dial frequently-dialled phone numbers by simply pressing
and holding one or two keys.You may choose speed dial entries from 2-99; speed dial
1 is reserved for voice mail access and the number is configured in your settings.
Note: A speed dial can be created only for a phone number stored in Contacts.

To create a speed dial for a phone number
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Open the contact and select the phone number to set up as a speed dial.
3. Press the Menu soft key, select Add Speed Dial, and then press the Action button.
4. Under Keypad assignment, enter the speed dial number to associate with the

phone number, and press the Done soft key.
Note: You can also create speed dials for Web addresses and e-mail addresses that 
are stored in Contacts.
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To make a call using a speed dial
• On the Home screen, press and hold the number on the keypad that you have

assigned as a speed dial for a number. If the keypad assignment is two digits, press
the first digit and press and hold the second digit.

To view speed dials you have created
• On the Home screen, press the Programs soft key, select More, select Shortcuts,

and then press the Action button.

Voice tags
You can record voice tags so that you can dial a phone number simply by speaking a
word.

To create a voice tag for a phone number
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Open the contact and select the phone number to set up as a voice tag.
3. Press the Menu soft key, select Add Voice Tag, and then press the Action button.
4. Wait for the audio and visual cue and begin recording your voice tag.
5. When prompted, repeat the voice tag to confirm.
6. If the voice tags match, the Smartphone will display a confirmation and replay the

voice tag.
Note: You can also create voice tags for Web addresses and e-mail addresses that are 
stored in Contacts.

To make a call using a voice tag
1. On the Home screen, press and hold the Record button.
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2. Say the word you have assigned as a voice tag for the phone number you want to
call. The Smartphone will play back the voice tag and then perform the specified
action.

3. If the Smartphone misinterprets the word, press the End button and start over.

To view voice tags you have created
• On the Home screen, press the Programs soft key, select More, select Shortcuts,

and then press the Action button.

Viewing and deleting shortcuts
Once you have set up speed dials and voice tags, you can view or delete all of your
shortcuts in the Shortcuts list.

To view shortcuts
• On the Home screen, press the Programs soft key, select More, select Shortcuts,

and then press the Action button.

To delete shortcuts
1. On the Home screen, press the Programs soft key, select More, select Shortcuts,

and then press the Action button.
2. Select the shortcut to delete, press the Menu soft key, select Delete, and then press

the Action button.

Advanced dialling options
The following information covers advanced dialling options that may be useful for
phone numbers requiring special dialling instructions.
International calls require a country code to be included in the phone number. The
country code is separated from the rest of the number sequence by a plus (+) sign.
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To insert an international country code
• Press and hold 0 until a plus sign (+) appears.
Note: You can insert a plus sign (+) into a contact's number or dial it directly from the 
keypad.
Some international calls require a three-second pause in the dialling sequence for the
call to process successfully.

To insert a three-second pause in a dialling sequence
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact, press the Action button, and then select the phone number to

modify.
3. Press the Edit soft key and press Left or Right to move the cursor between the num-

bers where you want to insert a three-second pause.
4. Press the Menu soft key, select Insert Pause, and then press the Action button. The

letter "p" will appear in the number to show where the three-second pause will occur
in the dialling sequence.

5. Press the Done soft key.

To insert a manual pause in a dialling sequence
There may be phone numbers that require a pause longer than three seconds in the
dialling sequence. For these cases, you can pause as long as you want and manually
continue the dialling sequence using theTalk button.
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact, press the Action button, and then select the phone number to

modify.
3. Press the Edit soft key, and press Left or Right to move the cursor between the num-

bers where you want the dialling sequence to pause before proceeding.
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4. Press the Menu soft key, select Insert Wait, and then press the Action button. The
letter "w" will appear in the number to show where the pause will occur in the dialling
sequence.

5. Press the Done soft key.
Note: When you make a call using Insert Wait, press the Talk button to continue the 
dialling sequence.
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Settings
This chapter introduces viewing and changing the settings on the Smartphone and
resetting the Smartphone to its original settings.

Viewing and changing settings
You can easily view and change settings to personalise the Smartphone for the way
you work. For example, you can change the sounds or use your own sounds for ring
tones, notifications, and reminders, use your own image for the Home screen
background, set up Call Diverting and Call Waiting to manage your calls more
efficiently, and more.

To view Settings
• On the Home screen, press the Programs soft key, select More, select Settings, and

then press the Action button.
Note: To view the remaining settings, select More and press the Action button.
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Telephony
Telephony settings are primarily used to set options for calls you receive, such as Call
Diverting, Call Waiting, and Caller ID.

To view Telephony settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Telephony, and then press the Action button.
The following table lists the telephony settings and their functions.

Sounds
Sounds settings are used to customise the sounds for ring tones, notifications, and
reminders.

Telephony set-
ting

Function

Call Barring Enables you to block incoming and/or outgoing calls.
Call Diverting Enables you to forward all or selected calls to another number.

Call Options
Enables you to change phone numbers, such as your voice mail
and SMS service center, answer incoming calls by pressing any
key, and other advanced call options.

Call Waiting Enables you to turn Call Waiting on or off.

Caller ID
Enables you to let your identification be known to all callers, only
your contacts, or no callers.

Channels Enables you to configure cell broadcast.

Fixed dialling
Enables you to limit your calling area to one or more specific
phone numbers and/or area codes.

Networks
Identifies your current network and changes your network selec-
tion from Automatic to Manual.
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To display Sounds settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Sounds, and then press the Action button.

To use your own sound
1. Go to where the sound file is stored on your desktop computer and copy the file. The

file format must be .wav or .mid(MIDI type 0).
2. In ActiveSync on your desktop computer, click Explore, double-click my

Smartphone, double-click IPSM, double-click Application Data, double-click
Sounds, and then paste the sound file into the Sounds folder.

Note:  If a Sounds folder does not exist in this directory, you will need to create new 
one.
3. On the Home screen on your Smartphone, press the Programs soft key, select

More, select Settings, select Sounds, and then press the Action button.
4. Select the item to customise, press Left or Right to select the sound, and then press

the Done soft key.
Note: Make sure that the Smartphone is connected to your desktop computer via USB 
before you open ActiveSync to paste the sound file.

Profiles
Profiles settings are used to configure how the Smartphone notifies you of events such
as an incoming call, an approaching appointment, or an arriving message. You can use
Profiles to change quickly how you receive notifications based on your situation. For
example, you may want the Smartphone to ring louder if a client is calling, or you may
not want the Smartphone to ring at all, but want to hear calendar reminders. The default
profile used with your Smartphone is the Normal profile. The name of the current profile
is displayed on the Home screen, and you can rename it.
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To view Profiles settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Profiles, and then press the Action button.
Note: You can also get to Profiles settings by selecting Profile [Type] from the Home 
screen.

Preset profiles
The following table shows the list of profiles and their attributes that initially come with
the Smartphone.

Profile
name

Ring type Ring volume
Notification

type
Notification

volume

System
sound vol-

ume
Normal Ring 3 Play sound 3 3
Silent Vibrate Off Vibrate Off Off

Meeting Vibrate 1 Play sound 1 Off

Indicates your
current profile
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To use profiles
1. On the Home screen, press Down to select Profile: [Type], and press the Action

button.
2. Select the profile, press the Action button to set the profile, and then press the Done

soft key.
Notes: 
• You can also select a different profile using the Quick List. Press the Power button (or

press and hold the Home button), select the profile, and then press the Action button.
• When a headset is plugged into the Smartphone, the Headset profile is used

automatically.

To modify a profile on the Settings menu
1. On the Home screen, press the Programs soft key, select More, select Settings,

select Profiles, and then press the Action button.
2. Select the profile to modify, press the Menu soft key, and then select Edit.
3. Modify the settings, and press the Done soft key.

Home screen
Home screen settings are used to change the Home screen layout, the colour scheme,
the background image, and the time delay before the Home screen appears when the
Smartphone is idle.

Loud Ring Loud Play sound Loud Loud
Automatic Toggles between Normal and Meeting, based on your calendar.
Headset Ring 3 Play sound 3 3

Car Ring 4 Play sound 4 4
Speaker-

phone
Ring Loud Play sound Loud Loud
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To view Home screen settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Home Screen, and then press the Action button.

To customise the Home screen with your own image
1. Go to where your image file is stored on your desktop computer, and copy the image

file. The file format must be .gif, .jpg, or .bmp.
2. In ActiveSync on your desktop computer, click Explore, double-click My

Smartphone, double-click IPSM, double-click Application Data, double-click Home,
and then paste the image file into the Home folder.

3. On the Home screen on your Smartphone, press the Programs soft key, select
More, select Settings, select Home Screen, and then press the Action button.

4. Select Background image, and press Left or Right to select your image.
5. Press the Done soft key.
Notes: 
• You can also select an image by selecting Background image and pressing the Action

button. This will show you the complete list of images to choose from.
• Make sure that the Smartphone is connected to your desktop computer via USB

before you open ActiveSync to paste the image file.
• For best results, use images with a 176 x 200 screen resolution to fit on the screen.

About
About settings display information about the Smartphone's operating system, including
version numbers and copyright information.

To view About settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select About, and then press the Action button.
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Accessibility
Accessibility settings are used to configure the system font size, multipress time out,
confirmation time-out, and in-call alert volume.

To view Accessibility settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Accessibility, and then press the Action button.

Data Connections
Data Connections settings enable you to set up Dial-up, Virtual Private Network (VPN),
Proxy, and General Packet Radio Service (GPRS) connections so you can connect to
the Internet or your corporate network. With a data connection, you can browse the
Web, download e-mail, chat using MSN Messenger, or synchronise wirelessly with the
server. Check with your service provider to see if a data connection has already been
set up for you, and if over-the-air configuration is supported.

To view Data Connections Settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Data Connections, and then press the Action button.

Dial-up connection
You need to set up a dial-up connection to connect directly to the Internet or to your
corporate network.

To create a dial-up connection to the Internet
1. On the Home screen, press the Programs soft key, select More, select Settings,

select Data Connections, and then press the Action button.
2. Press the Menu soft key, select Edit Connections, and then press the Action button.
3. Select Dial-up Connections, and press the Action button.
4. Press the Menu soft key, select Add, and then press the Action button.
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5. Under Description, enter a name for the connection.
6. Under Connects to, press Left or Right to select The Internet.
7. Enter the appropriate information for the remaining fields, and press the Done soft

key.

To create a dial-up connection to your corporate network
1. On the Home screen, press the Programs soft key, select More, select Settings,

select Data Connections, and then press the Action button.
2. Press the Menu soft key, select Edit Connections, and then press the Action button.
3. Select Dial-up Connections, and press the Action button.
4. Press the Menu soft key, select Add, and then press the Action button.
5. Under Description, enter a name for the connection.
6. Under Connects to, press Left or Right to select My Corporate Network.
7. Enter the appropriate information for the remaining fields, and press the Done soft

key.

VPN connection
A VPN connection is used to access your corporate network using an existing Internet
connection.

Proxy connection
A proxy connection is used to access the Internet using an existing connection to your
corporate network.

GPRS connection
If there is GPRS coverage in your area, you can set up a GPRS connection to access
your corporate network or the Internet.
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Date and Time
Date and Time settings enable you to change the local time zone and the current date
and time, and to set the alarm.

To view Date and Time settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select Date and Time, and then press the Action button.

Owner Information
Owner Information settings are used to enter and display personal information, such as
your name, phone number, and e-mail address. This is helpful, for example, in the
event that you lose your Smartphone so that you can be contacted if it is found.

To view Owner Information settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Owner Information, and then press the Action button.

Power Management
Power Management settings are used to display power-saving settings, such as
changing the backlight brightness and the backlight and display time-outs, and to check
the battery level.

To view Power Management settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Power Management, and then press the Action button.

Regional Settings
Regional Settings are used to change the Smartphone's language, date, and time style,
as well as number and currency formatting options.
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To view Regional Settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Regional Settings, and then press the Action button.

Remove Programs
Remove Programs settings enable you to remove programs installed on the
Smartphone, with the exception of core programs that came with the Smartphone, such
as Contacts, Calendar, and Internet Explorer.

To view Remove Programs settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Remove Programs, and then press the Action button.

Security
Security settings are used to enable phone lock or SIM lock and to set the phone lock
password.

To view Security settings
• On the Home screen, press the Programs soft key, select More, select Settings,

select More, select Security, and then press the Action button.

Phone Settings
Phone Settings allow you to customise flip answer on/off control, display style and
screen contrast.

To view Phone Settings
On the Home screen, press the Programs soft key, select More, select Settings,
select More, select Phone Settings, and then press the Action button.
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Note: When you are on a data/GPRS call or talking using a headset, the Flip answer 
function will be deactivated automatically. To end calls under these situations, press the 
End button.
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Messaging Features
This chapter introduces basic messaging features, such as sending and receiving e-
mail and Short Message Service (SMS) messages, viewing and managing your mes-
sage folders, customising message notifications, and using MSN Messenger to com-
municate with others.

Sending e-mail and SMS messages
There are several ways to send e-mail and SMS messages with your Smartphone. The
most common way to send messages is from Inbox or from a contact card.
For information about text input, see "Entering text and numbers on your Smartphone"
on page 32.

Sending messages from Inbox
You can send e-mail messages by synchronising, or by connecting directly to an e-mail
server through your Internet service provider (ISP) or a corporate network.
For information about Microsoft ActiveSync, see "Beaming information" on page 93.

To configure e-mail account
You have to configure your phone first before you send/receive e-mail and SMS.
1. On the Home screen, press the Programs soft key, select Inbox, and then press the

Action button.
2. Press the Menu soft key, select Options and press Action button.
3. Select E-mail Setup and press Action button.
4. Press Next and enter all the necessary information. Press Finish when the configu-

ration is complete.
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To compose an e-mail or SMS message from Inbox
1. On the Home screen, press the Programs soft key, select Inbox, and then press the

Action button.
2. Press the New soft key, enter an e-mail address or SMS number in the To field, or

select a name from Contacts by pressing the Menu soft key and select Insert Con-
tact, and then press the Action button.

3. Press Down twice and enter a subject.
4. Press Down, enter your message, and then press the Send soft key.
Notes:  
•  To insert the @ sign in an e-mail address, in Multipress mode, press the 1 key once.

Then, when you need to insert the period in the e-mail address, press the 1 key
again. 

•  To add multiple recipients, separate each name with a semicolon by repeatedly press-
ing the 1 key in Multipress mode until the semicolon appears.
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To request a delivery receipt for an SMS message you are composing
1. Before you send the SMS message, press the Menu soft key, select Message

Options, and then press the Action button.
2. Select the Request SMS text message delivery notification check box, and then

press the Done soft key.

Sending messages from a contact card
You can send a message quickly to a contact if you have an e-mail address or SMS
number included in the contact card.

To compose an e-mail or SMS message from a contact card
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact and press the Action button.
3. Select the e-mail address or SMS number, and press the Action button.
4. Enter a subject.
5. Press Down, enter your message, and then press the Send soft key.

Inserting predefined text into messages
Save time when composing mail by inserting predefined text into your messages.You
can edit the predefined text to create words or phrases that you frequently use in mes-
sages.

To insert predefined text into a message
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Press the New soft key and, in the Subj or body text field, press the Menu soft key,

select Insert Text, and then press the Action button.
3. Select the predefined text to insert into your message and press the Insert soft key.
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To edit your predefined text messages
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Press the Menu soft key, select Options, select Predefined Text, and then press the

Action button.
3. Select and modify the text you want to change, and press the Done soft key.

Inserting voice recordings into messages
Inserting a voice recording into a message is easy. Inserting a voice recording is useful
when you want to verbally explain information that is contained in the message.

To insert a voice recording into a message
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Press the New soft key and, in the body text field, press the Menu soft key, and then

select Insert Recording.
3. Press the Record soft key to start recording, and press the Stop soft key to stop

recording.
4. Press the Done soft key to insert the recording into your message.
Note: Only one voice recording at a time can be created. A new voice recording will 
replace the prior recording.

Receiving e-mail and SMS messages
You can receive e-mail messages through Inbox synchronisation or by connecting to
your e-mail server. You can then view all of your e-mail messages in Inbox. When you
connect to the e-mail server or synchronise Inbox with your desktop computer, only the
first 5 KB of each new message are downloaded to Inbox on your Smartphone by
default. If you are using an IMAP4 or POP3 server, only the first 1 KB of each new mes-
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sage is downloaded by default. Only small attachments are downloaded and the origi-
nal messages remain on the e-mail server or your desktop computer. SMS messages
that are sent to you instantly appear in Inbox, and are not synchronised.
Note: For more information about synchronising Inbox, see "Beaming information" on 
page 93.

Opening messages
E-mail and SMS messages that are sent to you are stored in Inbox.

To open a message
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Select the message to open and press the Action button.
Note: If you want to create a contact card for the sender, press the Menu soft key, 
select Add Sender to Contacts, and then press the Action button.

Receiving meeting requests
When you accept a meeting request that arrives in Inbox, the meeting will immediately
appear in Calendar on your Smartphone, and a message will be sent back to the meet-
ing organiser the next time you synchronise Inbox.
For more information about synchronising Calendar, see "Beaming information" on
page 93.

To accept a meeting request
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Select the meeting request, press the Action button, and then press the Accept soft

key.
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Receiving complete messages
You can specify messages to receive in full, instead of receiving only the first 0.5 KB set
by default.

To receive a complete message
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Select the message to receive in full, press the Menu soft key, select Mark for

Download, and then press the Action button.
The complete message will be retrieved the next time you synchronise or connect to
your e-mail server.
Note: When you delete a message on your Smartphone, it is also deleted from the e-
mail server the next time you connect.

Receiving message attachments
You can download message attachments to your Smartphone. Attachments are dis-
played as a list of hyperlinks at the bottom of the e-mail message, and are preceded by
an attachment icon. The text of the hyperlink contains the file name followed by the size
of the attachment, thereby helping you to determine whether you want to download the
attachment.
Note: On POP3 messages, the attachment size is omitted.
The attachment icon has the following three states:
• Not downloaded
• Downloaded
• Marked for download

To download an attachment
• In an open message containing an attachment for download, select the attachment

and press the Action button.
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The attachment will be downloaded when you synchronise or request to send and
receive e-mail.

To view a downloaded attachment
• In an open message containing a downloaded attachment, select the attachment and

press the Action button.
Note: You can view attachments only for file types that are supported by your Smart-
phone.

Viewing your message folders
Your Smartphone stores messages in the following folders.
• Deleted Items, where messages that you delete are stored until you empty this folder.
• Drafts, where messages that you save before sending are stored.
• Inbox, where all messages that you receive arrive by default.
• Outbox, where sent e-mail messages are stored until you synchronise or connect to

your e-mail server. SMS messages are sent immediately over the network and will
appear in your Outbox folder only for a few seconds.

• Sent Items, where copies of e-mail messages that you send are stored.

To view message folders
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Press the Menu soft key, select Show Folders, and then press the Action button.
Note: If your e-mail account supports folders, you can view multiple folders to reflect 
the folder structure that you have created on your e-mail server. Messages you down-
load from the server will then be placed automatically in the appropriate folders on your 
Smartphone.
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Managing Inbox
All e-mail and SMS messages are stored in Inbox. By default, the most recently
received messages are displayed at the top of the Inbox list. Using the menu options,
you can quickly compose, delete, forward, and reply to messages.You can also cus-
tomise Inbox settings to control the way you send, receive, and view messages.

To view Inbox
• On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.

Using Inbox menu options
It is easy to accomplish common messaging tasks from Inbox. Press the New soft key
to compose a new message, or press the Menu soft key to forward, delete, and reply to
messages, access Inbox options you can customise, and more.

To view Inbox menu options
• On the Home screen, press the Programs soft key, select Inbox/SMS, press the

Action button, and then press the Menu soft key.

Indicates opened
e-mail

Indicates new
e-mail



72 - Messaging Features

The following table lists Inbox menu options and their functions.

Customising Inbox options
You can optimise Inbox for the way you work. For example, you can change the way
your messages are displayed, specify how you want your messages to be sorted, spec-
ify the volume and limit the size of messages you want to automatically download,
change your synchronisation schedule, and more.

To customise Inbox Options
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.

Inbox menu option Function
New Message Opens a new message.

Reply Replies to an open or selected message.
Forward Forwards the selected message.
Delete Deletes the selected message.

Mark for Download
Retrieves the entire e-mail message from the e-mail server
the next time you connect.

Mark as Read
Displays the header text of a message in Inbox in light-
face, indicating that the message has been read.

Mark as Unread
Displays the header text of a message in Inbox in bold,
indicating that the message has not been read.

Options
Displays a list of Inbox options that you can customise
(see the following table).

Send/Receive E-mail
Connects to your e-mail server to send and receive mes-
sages.

Show Folders Displays all message folders.
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2. Press the Menu soft key, select Options, and then press the Action button.
3. Select the option to customise, and press the Action button.
4. Modify the settings to change, and press the Done soft key.
The following table lists the Inbox options and their functions.

Inbox option Function

Display
Enables you to change the message information displayed
in Inbox.

Sending
Enables you to specify whether you want to include an
original copy of the message in your reply, save a copy of
your sent messages, or use Unicode for SMS messages.

Receiving
Enables you to specify the volume and limit the size of
new messages that are automatically downloaded.

Predefined Text
Enables you to edit the predefined text that you can insert
in messages.

E-mail Setup

Enables you to configure your Smartphone to send and
receive e-mail messages. Your service provider or network
administrator will need to provide you with the necessary
information to connect to your e-mail server.

Automatic Synchroni-
sation

Enables you to set up and change your synchronisation
schedule.

Import Messages from
SIM

Enables you to import SMS messages from a SIM card to
Inbox. The messages are not removed from the SIM card
after they are imported.
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Message notifications
Your Smartphone makes a sound to alert you when new messages arrive. The number
of unopened messages is displayed on the Home screen, depending on your Home
screen settings, and an envelope icon is shown on the top of the display. You are noti-
fied in different ways for the types of messages you receive.
SMS messages: These messages are delivered immediately to your Smartphone. If
your Smartphone is turned off when SMS messages arrive, you are notified the next
time you turn your Smartphone on. A closed envelope icon , indicating an unopened
SMS message, is shown on the top of the display, accompanied by an SMS sound
alert. You can view new SMS messages in Inbox.
E-mail messages: When you connect to your e-mail server, you are notified of new e-
mail messages by the closed envelope icon shown on the top of the display, accom-
panied by an e-mail sound alert. You can view new e-mail messages in Inbox.
Voice mail messages: You are notified of new voice mail messages available on the
voice mail system by the new voice mail icon shown on the top of the display. You
can then listen to your new voice mail messages by pressing the Voice Mail soft key, if it
is displayed, or by dialling your voice mail service number.

To modify a sound alert for notifications
1. On the Home screen, press the Programs soft key, select Settings, select Sounds,

and then press the Action button.
2. Select the item to modify, press Left or Right to choose a new sound, and then press

the Done soft key.

SMS messages
You can send and receive SMS messages up to 160 characters in size over the Smart-
phone network. If an SMS message is longer, it will automatically be sent in chunks as
several small SMS messages, and will then be unified as one SMS message after all of
the small SMS messages have been received.
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The advantages of SMS messages include the following:
• SMS messages are sent instantly.
• SMS messages can be sent or received during a voice or data call.
• Most mobile phones support SMS, so most recipients can read SMS messages you

send.
Note: SMS messages are not synchronised, and you cannot use them to send or 
receive attachments.

To import SMS messages from the SIM card to Inbox
1. On the Home screen, press the Programs soft key, select Inbox/SMS, and then

press the Action button.
2. Press the Menu soft key, select Options, select Import Messages from SIM, and

then press the Action button.
Notes: 
•  You cannot export messages from your Smartphone to a SIM card.
•  SMS messages are not removed from the SIM card after they are imported to Inbox.

Communicating with MSN Messenger
You can use MSN Messenger on your Smartphone to send instant messages. MSN
Messenger on your Smartphone provides the same chat environment as MSN Messen-
ger on your desktop computer. Features of this environment include:
• Sending and receiving instant messages.
• Seeing the status of others in your Messenger contacts list, or changing your own sta-

tus (e.g., available, busy, out to lunch).
• Inviting other people to a chat conversation.
• Blocking contacts from seeing your status or sending you messages.
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Getting started with MSN Messenger
To use MSN Messenger, you need a Microsoft.NET Passport account unless you
already have a Hotmail account. To set up a Microsoft.NET Passport account, go to:
http://www.passport.com. Once you have this account, you will need:
• A connection on your Smartphone, such as a modem or wireless connection, that

enables you to connect to the Internet.
• To sign in to MSN Messenger using your Microsoft.NET Passport.

To sign in and out of MSN Messenger
1. On the Home screen, press the Programs soft key, select MSN Messenger, press

the Action button, and then press the Sign In soft key.
2. Enter your sign-in name (Example: name_123@hotmail.com) and password, and

then press the Sign In soft key.
3. To sign out, press the Menu soft key, select Sign out, and then press the Action

button.
Note: If you do not sign out of MSN Messenger, you will remain on a data connection. 
This may result in additional charges from your service provider.

To send an instant message
1. Sign in to MSN Messenger.
2. Select the person in MSN Messenger to whom you want to send an instant message,

and press the Send soft key.
3. Enter your message, and press the Send soft key.
Note: To quickly add common messages, press the Menu soft key, select My Text, and 
then select the text you want to use in the message.
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For information about text input, see "Entering text and numbers on your Smartphone"
on page 32.

To invite a contact to an ongoing chat
• Press the Menu soft key, select Invite, and then select a contact.

To see who is already chatting, or to change between chats
• Press the Menu soft key, and select Chats.

To accept or change between chats
• Press the Menu soft key, select Chats, and then select the contact to begin chatting.

To add a contact
• In the Messenger contacts list, press the Menu soft key, select Add Contact, and

then follow the directions on the screen.

To delete a contact
• In the Messenger contacts list, select the contact's name, press the Menu soft key,

and then select Delete Contact.
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To block or unblock a contact from seeing your status and sending you mes-
sages
• In the Messenger contacts list, select the contact's name, press the Menu soft key,

and then select Block or Unblock.

To change your status
1. In the Messenger contacts list, select your name, and press the Action button.
2. Select a status description, such as Away, and press the Action button.

To change your displayed name
1. In the Messenger contacts list, press the Menu soft key, select Options, and then

select Passport Account.
2. Enter the name that you want others to see when you send instant messages.
Note: You must be signed in to MSN Messenger to change your displayed name.

Highlight your status and
press the Action button
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Contacts, Calendar and Tasks
This chapter introduces features on your Smartphone that help you manage and keep
track of contacts, appointments, and schedule, and maintain a "things to do" list. This
chapter also explains how to send and receive contact and appointment information
between your Smartphone and another mobile device or a desktop computer (beaming
data) by using infrared.
For information about synchronising Contacts, Calendar, andTasks, see "Beaming
information" on page 93.

Using Contacts
You can think of Contacts as an address book, where you can store information about
people and businesses you communicate with in contact cards. For example, you can
store multiple phone numbers, e-mail and street addresses, Web pages, and other
information that relates to the contact, such as a birthday or anniversary date. You can
use Contacts to dial phone numbers and compose e-mail and SMS messages directly
from a contact card.

The Contacts list
The Contacts list displays the names of your contacts alphabetically, along with an
abbreviation for the default communication method, such as the person's work phone
number (w) or home phone number (h). This makes it easy to reach the contact using
the method you prefer.
Note: If the contact card includes a work phone number, your Smartphone will automat-
ically set it as the default number.

To access Contacts
• On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
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Note: You can also access Contacts by pressing the Contacts soft key on the Home 
screen, if it is displayed.

The following table shows possible abbreviations that might be displayed in the Con-
tacts list and their meanings.

Contact list abbreviation Meaning
w Work phone
w2 Second work phone
h Home phone
h2 Second home phone
m Mobile phone

pgr Pager
car Car phone
sms SMS address

e E-mail address
e2 Second e-mail address
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To call a contact using the default number
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to call, and press the Talk button.
Note: If you have a long list of contacts and you don't see the contact you want to call 
on the first screen, enter the first few letters of the contact's name. The Smartphone will 
search through the entire Contacts list and display the name.

To call a contact using a number other than the default number
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact, press Left or Right to display the abbreviation for the number you

want to use, and then press the Talk button.
Note: Selecting another abbreviation changes the default number.

To find a contact by entering a name
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Begin entering the name of the contact you want until the name is displayed.

For example, to find "Sandra," enter 7, 2, 6, 3, 7, 2 because these numbers corre-
spond with the letters for that name on the keypad.

To filter contacts
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.

e3 Third e-mail address
web Web page
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2. Press the Menu soft key, select Filter, and then press the Action button.
3. Select a filter (Business, Miscellaneous, or Personal), and press the Action button.

To create a new contact
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Press the New soft key, enter the information for the new contact and press the Done

soft key.
Note: When you create a new contact on your Smartphone, you can synchronise Con-
tacts with your desktop computer or a server to keep your contact information up-to-
date in all locations.

To delete a contact
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to delete, press the Menu soft key, select Delete, and then press

the Action button.

Contact cards
A contact card displays all of the information that you have entered for the contact, such
as the name of the person or business, phone numbers, e-mail addresses, and more.
From a contact card, just select a phone number and press the Talk button to dial the
number. You can also select an e-mail address and press the Action button to begin
composing a message to the contact.

To view a contact card
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
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2. Select the contact to view, and press the Action button.

To call a contact from a contact card
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact, and press the Action button to open the contact card.
3. Select the number to use, and press the Talk button.

To send an e-mail from a contact card
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to whom you want to send an e-mail message, and press the

Action button to open the contact card.
3. Select the e-mail address, and press the Action button.
4. Enter a subject, press Down, and compose your message in the body text field, and

then press the Send soft key.

Work number
Mobile number
E-mail address

SMS message
number

Number in bold
denotes default
number
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To edit a contact
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to edit, and press the Action button to open the contact card.
3. Press the Menu soft key, select Edit, and then press the Action button.
4. Make the changes, and press the Done soft key.

Using contact card menu options
Using the contact card menu options, you can quickly apply a speed dial or voice tag to
the contact, change the default method for communicating with the contact, beam the
contact card to another mobile device or a desktop computer using infrared, delete the
entire contact card, or edit the contact card information.

To view contact card menu options
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to open, press the Action button, and then press the Menu soft

key.
The following table lists the contact card menu options and their functions.

Contact card menu
option

Function

Add Speed Dial*
Enables you to create a shortcut to a phone number, e-mail
address, or Web URL by assigning one or two numbers as a
speed dial.

Add Voice Tag*
Enables you to create a shortcut to a phone number, e-mail
address, or Web URL by assigning a recording.
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* For information about creating speed dials and voice tags, see "Speed dials" on page
48.

Using Calendar
Calendar is the scheduling program on your Smartphone, where you can create and
view appointments, and view your calendar by day, week, or month.

To access Calendar
• On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.

To create a new appointment
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Press the Menu soft key, select New, and then press the Action button.
3. Enter information in the fields displayed.

To set a reminder for the appointment, under Reminder, select the amount of time
before the appointment that you want the reminder to appear.

4. Press the Done soft key.
Note: When you create a new appointment on your Smartphone, you can synchronise 
Calendar with your desktop computer or a server to keep your schedule information up-
to-date in all locations.

Set As Default
Makes the selected phone number or e-mail address the
default communication method for the contact.

Beam Contact
Sends the contact card to another mobile device or a desk-
top computer using infrared.

Delete Removes the contact card from the Contacts list.
Edit Enables you to modify information in the contact card.
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To view an appointment
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Select the appointment to open, and press the Action button.

To edit an appointment
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Select the appointment to edit, press the Action button, and then press the Edit soft

key.
3. Make the changes, and press the Done soft key.
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To delete an appointment
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Select the appointment to delete, press the Menu soft key, select Delete, and then

press the Action button.

Viewing your schedule
You can view your schedule using three different views: Agenda, Week, and Month.

Agenda view
The Agenda view in Calendar is the default view for calendar information. This view dis-
plays meetings and appointments scheduled for the current day. The appointments are
shown in chronological order according to start time. All-day appointments are shown
as a single line at the top of the Agenda view. Up to three all-day events will be dis-
played.

To view your agenda for the current day
• On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
• If you are in Calendar and you are using the Week or Month view, press the Menu

soft key, select Agenda View, and then press the Action button.
Note: To look at your agenda for previous or approaching dates, press Left or Right.

To view your agenda for a specific date
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Select the Menu soft key, select Go to Date, and then press the Action button.
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3.Enter the date you want to view, and press the Done soft key.

Week view
The Week view shows your schedule for the specified week. This view allows you to get
a quick indication of your free and busy time, and allows you to create an appointment
at a selected time easily.
The Week view displays the hours from 9:00 A.M. to 5:00P.M. in one-hour increments
by default on the left side of the screen. You can press Up or Down to show the hours
before or after those displayed.
Note: If you press Up or Down and leave Week view, the hours last shown will be dis-
played the next time you return to Week view.

To view appointments for the week
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Press the Menu soft key, select Week View, and then press the Action button.
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Note: To change settings for Week View, press the Menu soft key, select Options, and 
then press the Action button.

Month view
The Month view provides an overview of your monthly schedule with arrow indicators
for morning and afternoon appointments. The arrows pointing upward represent morn-
ing appointments, and the arrows pointing downward represent afternoon appoint-
ments. An all-day event is indicated by a box inside the calendar day. If you have
morning and afternoon appointments and an all day event, a box will surround that cal-
endar day.

To view your schedule for the month
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
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2. Press the Menu soft key, select Month View, and then press the Action button.

Importing calendar information
You can import calendar information from another calendar program if it uses the iCal or
vCal format. The calendar information can be imported from attachments in e-mail mes-
sages, SMS messages, links in Microsoft Pocket Internet Explorer, or by infrared.

Using Tasks
A task is a personal or work-related project, assignment, or errand to track through
completion. A task can occur once or repeatedly. A recurring task can repeat at regular
intervals or repeat based on the date you mark the task complete. For example, you
might want to pay a bill on the last Friday of every month, or get a haircut when one
month has passed since your last haircut.

The Tasks list
The Tasks list shows your "things to do" list. An item is followed by an exclamation mark
if it has been marked as high priority and a down arrow if it has been marked as low pri-
ority. Overdue tasks are displayed bold and red. Completed tasks are displayed with
the corresponding check box selected.
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Note: If you synchronise tasks with your desktop computer, completed tasks are 
removed from your Smartphone after synchronisation. They are then displayed in gray 
with a strikethrough on your desktop computer.

Using the Tasks list

To create a new task
1. On the Home screen, press the Programs soft key, select More, select Tasks, and

then press the Action button.
2. Select the Enter new task here field, enter the task, and then press the Action but-

ton.
Notes: 
• When you create a new task on your Smartphone, you can synchronise tasks with

your desktop computer to keep your Tasks list up-to-date in both locations.
•  If you create a new task with a reminder on your desktop computer, you can synchro-

nise tasks with your Smartphone to hear the reminder on your Smartphone.
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To mark a task as complete
1. On the Home screen, press the Programs soft key, select More, select Tasks, and

then press the Action button.
2. Select the task, and press the Complete soft key.

To mark a completed task as incomplete
1. On the Home screen, press the Programs soft key, select More, select Tasks, and

then press the Action button.
2. Select the task, and press the Activate soft key.

To delete a task from the Tasks list
1. On the Home screen, press the Programs soft key, select More, select Tasks, and

then press the Action button.
2. Select the task, and press the Delete soft key.

Creating Voice Notes
Voice Notes are used to create short voice recordings. Recordings are included in the
All Notes list and are named consecutively (Recording 1, Recording 2, and so on).

To create a Voice Note
1. Hold the Smartphone's microphone near your mouth.
2. Press jog dial, and press the Record soft key to begin recording your voice note.
3. Press the Stop soft key to stop recording your voice note.
Note: To listen to a recording, select it from the All Notes list, press the Menu soft key, 
select Play, and then press the Action button.

To rename a recording
1. Press jog dial, and select the recording to rename.
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2. Press the Menu soft key, select Rename, and then press the Action button.
3. Under Name, enter a new name for the recording, and press the Done soft key.

Beaming information
You can use the infrared port on your Smartphone to send and receive (beam) calendar
appointments and contact cards between your Smartphone and Synchronising Informa-
tion with another mobile device or a desktop computer that has an infrared port and
supports VCards and VCal.

To beam a contact
1. On the Home screen, press the Programs soft key, select Contacts, and then press

the Action button.
2. Select the contact to beam, press the Menu soft key, select Beam Contact, and then

press the Action button. Align the infrared ports so that they are unobstructed and
within close range of each other, and press the Beam soft key.
Status information will then be displayed, indicating the name of the device your
Smartphone is beaming to, and whether the beaming process is pending, done, or
has failed.

To beam an appointment
1. On the Home screen, press the Programs soft key, select Calendar, and then press

the Action button.
2. Select the appointment to beam, and press the Action button to open the appoint-

ment.
3. Press the Menu soft key, select Beam Appointment, and then press the Action but-

ton.
4. Align the infrared ports so that they are unobstructed and within close range of each

other, and press the Beam soft key.



94 - Contacts, Calendar and Tasks

Status information will then be displayed, indicating the name of the device your Smart-
phone is beaming to, and whether the beaming process is pending, done, or has failed.

To receive beamed information
1. On the Home screen, press the Programs soft key, select More, select Accesso-

ries, and then press the Action button.
2. Select Infrared Receive, and press the Action button.
3. Align the infrared ports so that they are unobstructed and within close range of each

other, and press the Yes soft key to receive the information.
Note: Your Smartphone can receive beamed files of any type, but some files may need 
to be copied to your desktop computer for viewing. 
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Synchronising Information
This chapter introduces basic concepts and features of Microsoft ActiveSync, and
explains how to set up Server ActiveSync, synchronise remotely, and create a
synchronisation schedule. This chapter also gives an overview of the different types of
Microsoft Outlook information you can synchronise.
For more information about ActiveSync, see ActiveSync Help on your desktop
computer.

Using ActiveSync
You can synchronise information on your desktop computer and/or a Microsoft
Exchange Server with the information on your Smartphone. ActiveSync compares the
information on your Smartphone with the information on your desktop computer and/or
the server and updates all locations with the most recent information. With ActiveSync,
you can:
• Keep your Outlook information up-to-date by synchronising your Smartphone with

your desktop computer.
• Choose to synchronise Inbox, Calendar, and Contacts with a server so that you have

the latest information, even when your desktop computer is turned off.
• Copy (rather than synchronise) files between your Smartphone and your desktop

computer.
• Control when synchronisation occurs by selecting a synchronisation schedule.
• Select which information types are synchronised and control how much information is

synchronised. For example, you can choose how many weeks of past appointments
to synchronise.

Note: Using Server ActiveSync, you can synchronise information directly with a Micro-
soft Exchange Server if your company is running Microsoft Mobile Information Server 
2002 or later.
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Installing ActiveSync
Before you begin synchronisation, install ActiveSync 3.6 or above on your desktop
computer (You can download ActiveSync to your desktop computer for free from the
website of Microsoft). ActiveSync is already installed on your Smartphone.

Creating a Partnership
After the installation is complete, the New Partnership Wizard helps you set up a part-
nership between your Smartphone and your desktop computer and/or a server so that
you can start synchronising information and customising your synchronisation settings.
Your first synchronisation process will automatically begin when you finish using the
wizard. After the first synchronisation, you will notice that your Outlook information now
appears on your Smartphone.
Note: To prevent synchronisation problems, select Synchronise with Microsoft Mobile 
Information Server and/or this desktop computer in the New Partnership Wizard only if 
you are certain that your company is running Microsoft Mobile Information Server 2002 
or later and you know the server name. Otherwise, select Synchronise with this desktop 
computer. For more information, contact your network administrator or service provider.

Connection status

Server synchronisation
status

Desktop synchronisation
status

Select to synchronise
via IR or change syn-
chronisation settings

Select to connect and
synchronise
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To start and stop synchronisation
You have to connect your Smartphone and your desktop computer using infrared port
on your Smartphone or cable before you can begin to synchronise information.
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. To start synchronisation, press the Sync soft key; to stop synchronisation, press the

Stop soft key.

Setting up Server ActiveSync
Before you can begin to synchronise information with a server, you may need to
request server configuration information, such as your user name, password, and the
name of the Microsoft Mobile Information Server, either from your service provider or
from your corporate network administrator. This configuration information may have
already been set up on your Smartphone, or you may have already been given this
information.

To set up Server ActiveSync
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. Press the Menu soft key, select Options, and then press the Action button.
3. Select Connection, and press the Action button.
4. Under Username, enter your Microsoft Exchange user name.
5. Under Password, enter your Microsoft Exchange password.
6. Under Domain, enter the name of the domain for your Microsoft Exchange Server (if

required).
7. Select Save password if you want your Smartphone to save your password so that

you need not enter it repeatedly.
8. In Server name, enter the name of the Microsoft Mobile Information Server to which

you want to connect.
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9.Press the Done soft key twice.
10.To begin synchronising with the server, press the Sync soft key.
Note: You can also set up a connection to synchronise remotely with a server when you 
first create a partnership between your Smartphone and desktop computer.

To stop synchronising with a server
You can stop synchronising an information type with a server on your Smartphone.
However, to change to synchronising that information type with your desktop computer
instead, you will need to change the synchronisation settings on the desktop computer.
For more information about synchronisation, see ActiveSync Help on the desktop com-
puter.
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. Press the Menu soft key, select Options, and then select the information type that

you no longer want to synchronise with a server, such as Calendar, Contacts, or
Inbox.

3. Clear the check box next to the information type that you no longer want to synchro-
nise with a server, and press the Done soft key.
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Synchronising Remotely
You can synchronise remotely with your desktop computer, or with a server, if you have
set up Server ActiveSync.

To synchronise remotely with a desktop computer
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. Press the Menu soft key, select Options, and then press the Action button.
3. Select PC Settings, and then press the Action button.
4. Select Include PC sync remotely when synchronising, and then press the Action

button.
5. Under Connect To, select the appropriate computer name, and press the Done soft

key.
6. To start synchronisation, press the Sync soft key.
Note: To synchronise remotely with a desktop computer, it must be turned on.

To synchronise remotely with a server
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. Press the Menu soft key, select Options, and then press the Action button.
3. Select the information type to synchronise with the server, press the Action button,

select the Synchronise [Information type] check box, and then press the Done
key.

Creating a server synchronisation schedule
You can create a server synchronisation schedule so that your information is automati-
cally synchronised with the server at time intervals that you specify.
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To create a schedule to synchronise with a server when your Smartphone is con-
nected to a desktop computer
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. Press the Menu soft key, select Options, select Schedule, and then press the

Action button.
3. Select the When connected to my PC, synchronise with the server every check

box, and select a length of time.
4. Press the Done soft key.

To create a schedule to synchronise with a server when your Smartphone is not
connected to a desktop computer (synchronise wirelessly)
1. On the Home screen, press the Programs soft key, select ActiveSync, and then

press the Action button.
2. Press the Menu soft key, select Options, select Schedule, and then press the

Action button.
3. Select the When not connected to my PC, synchronise with the server every

check box and select a length of time.
4. Press the Done soft key.

Synchronising information
This section provides an overview of the types of Outlook information you can synchro-
nise. By default, ActiveSync does not automatically synchronise all types of Outlook
information. Use ActiveSync options to turn synchronisation on and off for specific infor-
mation types.
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Synchronising Inbox
When you select Inbox for synchronisation in ActiveSync, e-mail messages are syn-
chronised as part of the general synchronisation process. During synchronisation, the
following events occur:
• Messages are copied from the Outlook Inbox folder on your desktop computer, or

from a Microsoft Exchange Server, to the Inbox folder on your Smartphone.
• By default, when synchronising Inbox information with your desktop computer, you

will receive only messages from the last three days and the first .5 KB of each new
message. You can also choose to download file attachments.

• By default, when synchronising Inbox information with a server, you will receive only
messages from the last three days and the first 500 bytes of each new message.

• The messages on your Smartphone and on your desktop computer are linked. When
you delete a message on your Smartphone, it is deleted from your desktop computer
the next time you synchronise, and vice versa.

• Messages in subfolders in other e-mail folders in Outlook are synchronised only if the
folders have been selected for synchronisation in Inbox on your Smartphone.

Note: SMS messages are not received in Inbox through synchronisation. Instead, they 
are sent to your Smartphone by way of your service provider.

Synchronising Calendar
Calendar items stored on your Smartphone can be synchronised with calendar items
stored on your desktop computer or on a Microsoft Exchange Server. By default, calen-
dar items from the last two weeks will be synchronised.
Calendar items created on your Smartphone are copied to your desktop computer and/
or server during synchronisation, and vice versa. Similarly, Calendar items that are
deleted from your Smartphone are deleted from your desktop computer and/or server
during synchronisation, and vice versa. This keeps your information up-to-date in all
locations.
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Synchronising Contacts
Contacts stored on your Smartphone can be synchronised with contacts stored on your
desktop computer or on a Microsoft Exchange Server. By default, all of your contacts
will be synchronised.
Contacts created on your Smartphone are copied to your desktop computer and/or
server during synchronisation, and vice versa. Similarly, contacts that are deleted from
your Smartphone are deleted from your desktop computer and/or server during syn-
chronisation, and vice versa. This keeps your information up-to-date in all locations.

Synchronising Tasks
Tasks stored on your Smartphone can be synchronised with tasks stored on your desk-
top computer. Task synchronisation is automatically selected in ActiveSync. By default,
all of your incomplete tasks will be synchronised.
Tasks created on your Smartphone are copied to your desktop computer during syn-
chronisation, and vice versa. Similarly, tasks that are deleted from your Smartphone are
deleted from your desktop computer during synchronisation, and vice versa. This keeps
your information up-to-date in all locations.
Note: Tasks can be synchronised only with your desktop computer; they cannot be syn-
chronised with a server.

Synchronising using an infrared connection
You can use an infrared connection to create a direct connection between your Smart-
phone and another mobile device or desktop computer quickly. This method is ideal for
quickly changing between multiple devices because there are no cables or adapters to
change. When creating a partnership, you must connect using infrared, a cable, or a
cradle connection.
For more information about synchronising using an infrared connection or other con-
nection types, see ActiveSync Help on your desktop computer.
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ActiveSync errors
Whenever ActiveSync cannot successfully synchronise your information, it displays an
error on your Smartphone.

To view more information about an ActiveSync error
• Press the Action button when the error text is displayed. ActiveSync will then display

more information about the error that occurred.
Note: Some types of errors can interfere with automatic synchronisation. If you suspect 
that a scheduled automatic synchronisation has not occurred, you should attempt to 
manually synchronise your information. Successfully completing manual synchronisa-
tion will reset automatic synchronisation. For more information, see the "Synchronising 
Information" section of ActiveSync Help on your desktop computer.

Exchanging files between Smartphone and desktop PC
With ActiveSync, you can exchange files between your Smartphone and desktop PC.

To exchange files between desktop PC to Smartphone
1. Connect your device to your desktop computer.
2. In ActiveSync, click Explore. Windows Explorer will open the Mobile Device window

for your Smartphone.
3. In Windows Explorer, browse to the file that you want to copy on your device or desk-

top computer.
4. Do one of the following:
• To copy the file to your Smartphone, right-click the file and click Copy. Place the cur-

sor in the desired folder for your device, right-click, and click Paste.
• To copy the file to your desktop computer, right-click the file and click Copy. Place the

cursor in the desired folder for your desktop computer, right-click, and click Paste.
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Internet, Entertainment, and More
This chapter explains how to browse the Web using Microsoft Pocket Internet Explorer,
play audio and video files using Microsoft Windows Media Player, set up a modem link,
play Solitaire, and use Calculator.

Using Internet Explorer
Using Pocket Internet Explorer, you can browse the Web on your Smartphone. Pocket
Internet Explorer on your Smartphone supports WAP (Wireless Application Protocol),
HTML (Hypertext Markup Language), and cHTML (compact Hypertext Markup Lan-
guage). The browser supports images and sounds, but it does not support frames on a
Web page.

To access Pocket Internet Explorer
• On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.

To disconnect from the Internet
• Press the End button.

Navigating in Pocket Internet Explorer
With Pocket Internet Explorer, the Favorites list is displayed as the main screen instead
of a home page.You can add your own favorites to this list for quick access to Web
sites you frequently visit. You can also access Smartphone How-To information any
time on the Web from the Favorites list. Access your Favorites list from any Web page
by simply pressing the Favorites soft key.
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To view a favorite
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Select a favorite to view, and press the Go soft key.

To activate a link
• Select a link, and press the Action button.
Note: Scroll vertically or horizontally to see all available links.

To access Smartphone How-To information in Favorites
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Select Smartphone How To, and press the Action button.

To enter the address of a Web site
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Press the Menu soft key, select Go To, and then press the Action button.
3. Enter the Web address, and press the Go soft key.

To return to a Web page you previously visited in the same session
• From a Web page, press the Back button.

To view a list of the most recently-visited Web pages
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Press the Menu soft key, select Go To, and then press the Action button.
3. Select View History, and press the Go soft key.
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To visit a Web page on the History list
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Press the Menu soft key, select Go To, and then press the Action button.
3. Select View History, and press the Go soft key.
4. Select the URL for a Web page, and press the Go soft key.
Note: While you are connected to the Internet, you can change between Pocket Inter-
net Explorer and other programs on your Smartphone by pressing the Home button. 
This will not close your Internet connection. To return to the page you were viewing, 
press the Back button.

Using the Favorites list
If you see a Web page you want to visit another time, mark it as a favorite. The next
time you want to visit that Web page, just select it from your Favorites list.

To add a Web page to your Favorites list
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Press the Menu soft key, select Go To, and then press the Action button.
3. Enter the Web URL, and press the Go soft key.
4. Press the Menu soft key, select Add Favorite, and then press the Action button.
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5. Enter a name for the Web site as you want it to appear on your Favorites list, and
press the Add soft key.

To create a new folder in Favorites
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Press the Menu soft key, select Add Folder, and then press the Action button.
3. Under Name, enter a name for the folder, and press the Add soft key.

To delete a favorite
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Select the favorite to delete, press the Menu soft key, select Delete, and then press

the Action button.

Cached Web pages
The Smartphone caches Web pages as they are downloaded to your Smartphone and
stores them on your Smartphone until the cache is full. If you go to a page that is

Enter
address
Select
folder

Enter name of
link
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already stored on your Smartphone, you will see the stored version when you select the
page. Choose Refresh from the menu to see the latest Web content for that page.

To refresh a Web page you have recently visited
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Select the Web page to revisit from your Favorites list or History list, and press the

Go soft key.
3. Press the Menu soft key, select Refresh, and then press the Action button.

Pocket Internet Explorer options
Use Pocket Internet Explorer options to change the way Web pages are displayed,
change the network you want to connect to, and free space on your Smartphone.

To view Pocket Internet Explorer options
1. On the Home screen, press the Programs soft key, select Internet Explorer, and

then press the Action button.
2. Press the Menu soft key, select Options, and then press the Action button.

Pocket Internet
Explorer Options

Function

General

Enables you to change the way Web pages are downloaded
and displayed. For example, you can choose to omit displaying
images, turn off sound, fit the Web page to the screen, request a
warning before moving from secure Web pages to nonsecure
Web pages, allow cookies, or change the language.

Connections
Enables you to change the network to connect to. For example,
change from "The Internet" to "My Corporate Network."
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Using Media Player
Using Windows Media Player 7.0 or later, you can play Windows Media audio and video
files and MP3 audio files on your Smartphone. You can also copy digital music and
video directly from your desktop computer to your Smartphone by using Media Player
or ActiveSync. For more information about copying files to your Smartphone, see the
Media Player Help on your desktop computer.
Media Player is easy to use; the controls are similar to the buttons on a compact disc
player.

Figure 23 Local Content screen

Playing files
You can play audio or video files, skip to another song or video, and increase or
decrease the volume.

Memory
Enables you to clear temporary Internet files, cookies, and your
Web history.
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To play or stop a file
• On the Local Content screen, press the Play soft key.
Note: To access the Local Content screen, press the Select soft key.

To skip to the beginning of the current file
• Press Left.

To skip to the beginning of the previous file
• Press Left twice quickly.

To skip to the next file
• Press Right.

To adjust the volume
• Use the jog dial to increase or decrease the volume.

To play a streaming media file on a network
1. On the Local Content screen, press the Menu soft key, select Open URL, and then

press the Action button.
2. Enter the Web URL, and press the Play soft key.

To play files randomly
1. On the Local Content screen, press the Menu soft key, select Settings, and then

press the Action button.
2. Select the Shuffle check box, and press the Done soft key.
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To play files repeatedly 
1. On the Local Content screen, press the Menu soft key, select Settings, and then

press the Action button.
2. Select the Repeat check box, and press the Done soft key.

To stop playback while using another program
1. On the Local Content screen, press the Menu soft key, select Settings, and then

press the Action button.
2. Select the Background play check box, and press the Done soft key.

Menu options when playing a file
When you are playing a file, you can use the menu options to start and stop playback,
skip to the next or previous file, display information about a file, configure volume and
playback settings, or add files to your Favorites playlist.

To access menu options when playing a file
• Press the Menu soft key.
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The following table lists the menu options and their functions that are available when
you play a file.

Local Content screen menu options
By using the menu options from the Local Content screen, you can start and stop play-
back, add files to your Favorites playlist, display information about a file, configure vol-
ume and playback settings, or delete a file.

To access Local Content screen menu options
• Press the Menu soft key.

Menu options when
playing a file

Function

Play/Stop Plays or stops playback of the current file.

Next
Skips to the next file on the current playlist. This command
is not available if the last file is the current selection.

Previous
Skips to the beginning of the current file on the current
playlist. If no file is playing, this command skips to the pre-
vious file on the current playlist.

Open URL
Plays a streaming media file on a network (for example,
content streamed from an Internet radio station).

Properties Displays information about the file that is playing.

Settings
Displays the Settings options, which enable you to adjust
the volume and various playback options.

Add to Favorites
Adds the streaming media file that is playing to the
Favorites playlist.
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The following table lists the Local Content screen menu options and their functions.

Using Media Player Favorites
You can connect to your favorite streaming media file and add it to Favorites. The next
time you want to listen to the streaming media file, just select it from Favorites.

To connect to a streaming media file
1. On the Local Content screen, press the Menu soft key, select Open URL, and then

press the Action button.
2. Enter the URL, and press the Play soft key.

To add a streaming media file to Favorites
1. Connect to a streaming media file on the Internet or other network.
2. Press the Menu soft key, select Add to Favorites, and then press the Action button.

Local Content menu
option

Function

Play/Stop Plays or stops playback of the current file.
Local Content Displays the Local Content view playlist.

Favorites Displays the Favorites view playlist.

Open URL
Plays a streaming media file on a network (for example,
content streamed from an Internet radio station).

Properties Displays information about the selected file.

Settings
Displays the Settings screen, which enables you to adjust
the volume and specify various playback options.

Delete
Permanently deletes the selected file from the Smart-
phone.
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To play a favorite
1. On the Local Content screen, press the Menu soft key, select Favorites, and then

press the Action button.
2. Select an item, and press the Play soft key.

To delete a favorite
1. On the Local Content screen, press the Menu soft key, select Favorites, and then

press the Action button.
2. Select an item, press the Menu soft key, select Delete, and then press the Action

button.

Licenses
Some digital media content from the Internet, CD tracks, and videos have associated
licenses that protect them from being unlawfully distributed or shared.
Licenses are managed and created using digital rights management (DRM), which is
the technology for securing content and managing the rights for its access. Some
licenses prevent you from playing content that is copied to your Smartphone.
Note: To ensure that the license is copied with the content, use the Portable Device (or 
Copy to CD or Device) feature in Windows Media Player 7.0 or later on your desktop 
computer to copy content to your Smartphone. For more information about copying 
content to your Smartphone and other portable devices, see the Windows Media Player 
Help on your desktop computer.

Supported File Formats
Media Player supports the following types of file formats.

Format File name extensions

Windows Media
.asf, .asx, .wax, .wm, .wma, .wmv, .wmx,

.wvx
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Supported Audio and Video Codecs
Media Player can play files that have been compressed by using any of the following
audio and video codecs.

Audio codecs
• Microsoft Windows Media Audio codec version 2.0, 7.0, and 8.0
• Fraunhofer IIS-A MPEG-1 Audio Layer-3 codec

Video codecs
• Microsoft Windows Media Video codec version 7.0 and 8.0
• Microsoft MPEG-4 video codec version 3.0
• ISO MPEG-4 video codec version 1.0

Modem Link
Using Modem Link, you can use your Smartphone as an external modem for another
device or computer. Modem Link allows you to use a serial port, infrared, or USB for this
connection.

To set up an infrared or USB modem connection
1. Make sure that your Smartphone is not connected to another device.
2. On the Home screen, press the Programs soft key, select More, select Accesso-

ries, and then press the Action button.
3. Select Modem Link, and press the Action button.
4. Under Connection, select USB or IrCOMM, press the Menu soft key, select Acti-

vate, and then press the Action button.

Moving Picture Experts Group (MPEG) .mp3
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5. Connect your Smartphone to the device with which you want to use your Smart-
phone as a modem.

To set up a serial port modem connection
1. Make sure that your Smartphone is not connected to another device.
2. On the Home screen, press the Programs soft key, select More, select Accesso-

ries, and then press the Action button.
3. Select Modem Link, and then press the Action button.
4. Under Connection, select Serial (COM1), press the Menu soft key, select Activate,

and then press the Action button.
Note: The default baud rate is set for 115,200. Do not change this default unless the 
port speed of the Smartphone or computer requires you to do so.

To activate the Modem Link
1. On the Home screen, press the Programs soft key, select More, select Accesso-

ries, and then press the Action button.
2. Select Modem Link, and then press the Action button.
3. Press the Menu soft key, select Activate, and then press the Action button.
4. Align the Smartphone's infrared (IR) port or connect the cable to the device.

To deactivate the Modem Link
1. On the Home screen, press the Programs soft key, select More, select Accesso-

ries, and then press the Action button.
2. Select Modem Link, and then press the Action button.
3. Press the Menu soft key, select Deactivate, and then press the Action button.
Note: Failing to deactivate the Modem Link when you are finished using it may result in 
problems with using ActiveSync in the same session.
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File Management
Using File Management, you can view the files stored in your Smartphone (and storage
card if inserted) and deal with them.

To use File Management
• On the Home screen, press the Programs soft key, select File Management and

then press the Action button.

To navigate in File Management
• Use the direction key to select a file (or a folder), and press the Action button to open

it.
• To return to the previous directory, press Prev.

To deal with files using File Management
Select a file and press Menu. The following table lists the menu options and their func-
tions that are available for dealing with a file.

Menu options Function
Cut Cut selected file.

Copy Copy select file.
Paste Paste file under current directory.
Delete Delete selected file.

Rename Rename selected file.

Misc
Open a submenu that allows you to sort the files under
current directory, view properties of selected file and view
information about the Smartphone.

Refresh Refresh the contents under current directory.
Exit Exit File Management.
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SIM Manager

Using SIM manager, you can manage and maintain the SIM phonebook easily.

To use SIM manager
• On the Home screen, press the Programs soft key. Select More and then press the

Action button. Select SIM Manager and then press the Action button.

To add a new phonebook entry to SIM card
• Press the New soft key, enter the name and phone number, press Done when fin-

ished.
• When entering, press the Menu soft key, select Cancel and then press Action button

to discard and exit this function.
• When entering the phone number, press the Menu soft key, select Insert Pause or

Insert Wait and then press Action button to insert a pause or a wait symbol after the
phone number.

To edit an entry
• Select an entry and press the Menu soft key. Select Edit and press the Action button

to edit this entry. Press Done when finished.



Internet, Entertainment, and More - 119

• When editing, press the Menu function key, select Dial and press the Action button to
dial the phone number. Select Delete and press the Action button to delete this entry.
Select Cancel and press the Action button to discard and exit this function.

To delete an entry
• Select an entry and press the Menu soft key. Select Delete and press the Action but-

ton to delete this entry.

To make a phone call
• Select an entry and press the Menu soft key. Select Dial and press the Action button

to dial the phone number.

To import/export entries between Contacts and SIM card
• Press the Menu soft key, select Contacts->SIM and press Action button. Select an

entry and press Action button, press the Start soft key to copy the entry which is
stored in the phone memory to the SIM.

To import/export Inbox/SMS to SIM card

To show SIM number
• Press the Menu soft key, select SIM Number and press the Action button. Your SIM

number will be displayed on the screen.

To view SIM status
• Press the Menu soft key, select SIM Status and press the Action button to view the

phonebook and SMS storage status on the SIM card.

SMS Manager
You can manage the SMS on the SIM card with this function.
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To use the SMS Manager
• Press the Menu soft key, select SMS Manager and press the Action button.

To add a SMS on SIM card 
• Press the New soft key, enter the phone number of recipient and the content. Press

Save to store the SMS and press Cancel to discard and exit this function.

To edit a SMS
• Select a desired SMS, press the Menu soft key, select Edit and press the Action but-

ton.
• Edit the phone number of recipient and the content, when finished, press Save to

store the SMS without overwriting the original SMS. Press Cancel to discard and exit
this function.

To delete a SMS
• Select a desired SMS, press the Menu soft key, select Delete and press the Action

button.

Using IA Album
IA Album for Smartphone combines two modes: Photos and Camera. In Camera
mode, you can use the Smartphone’s attached camera to snap new photos, or shoot
video clips with accompanying audio. Then use Photos mode to view/play, organise,
manipulate, and manage any images/videos you have captured or have obtained from
other sources, as well as WAV audio files.

Installing and Starting IA Album
If you are installing IA Album from a companion CD, follow the instructions on your
computer screen and your Smartphone screen. If you are installing from a Storage
Card, follow the instructions on your Smartphone screen. We strongly recommend that
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you install IA Album to your phone’s memory. After installing, you will find two ways to
start IA Album from your Smartphone’s Programs menu. If you have a built-in or
attached camera, select Camera to invoke IA Album in the Camera mode. Or, select
Photos to start Photos mode.

Camera Mode
When in Camera mode, use Image Capture submode to capture a single still image;
Burst Capture submode to auto-capture multiple images in quick succession; Compo-
sition Capture submode to place capture images into ”digital picture frames” (tem-
plates); or Video Capture submode to capture video clips.

To switch submodes
• Select Capture Mode from the menu, or press 1 key on your Smartphone keypad to

switch to different submodes.
Note: In any submode (depending on the current capture resolution) you can press the 
Up key on your Smartphone to zoom in, or the Down key to zoom back out.

Image Capture submode
When in Image Capture submode, you can capture a single still image be either press-
ing the Left soft key or the Action button. For still-image capture, you can specify a cap-
ture size (in the example below it is 640 x 480), a zoom ratio (1x below indicates
currently no zoom), disable the “snap“ sound when you take a picture, and use the
timer to take self-portraits, among other settings. The number of images you can cap-
ture, according available memory and your current settings, is always displayed.
The preview screen and main menu of image Capture submode are shown below. The
General options screen is partially shown on the right (select Options>General on the
menu to access it).
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Video Capture submode
To start the video recording process, press the Left soft key or the Action button. These
acts an On/Off toggle; that is, to stop recording, press either of them again to stop the
recording process. By default, audio is recorded along with your video. To turn this off,
select Options>Video from the menu or press 6 on your keypad to toggle audio On
and Off. The amount of time available for capturing new video clips, according to your
current settings and memory available, is always displayed in a minutes:seconds for-
mat.

Burst Capture submode
The Burst submode allows you to capture multiple “still“ images consecutively after
pressing Capture just once. To specify the number of images to be captured, select
Options>Image (this screen is shown below). In the Burst Number field, select the
desired number (3 is the default setting). The Title Bar will display the current value. In
the example below, 8 images will be captured in quick succession, although you will
only hear the “Snap“ sound once. The captured images are cached by the program,
and you can then choose which ones you want to save (see center figure below, which



Internet, Entertainment, and More - 123

displayed after Capture was finished). Press the Right or Left button to select.To dis-
card, use the Right soft key.

Composition Capture submode
In Composition Capture submode, you can use Select Template on the menu to select
a “digital picture frame“ into which your captured image will be placed. In the Select
Template screen, press the Left or Right buttons to view the available templates, then
press the Left soft key (“OK“) to select the current template. The capture screen will
then appear (below right). The incoming video stream will be visible in the empty area
(hole) of the template, known as the “place holder“. Press the Action button or Left soft
key as you normally would to capture the image. It will be saved together with the pic-
ture frame.
Note: Some templates may contain multiple placeholders, meaning multiple shots 
would be required. You can download additional templates for free from the web site 
(www.iastyle.com). If you do so, you will need to place them in the \My Docu-
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ments\Frames folder of your Smartphone’s local storage in order for IA Album to be 
able to find them.

Photos Mode
Select Photos from Programs to browse, manipulate, and view/play image and video
files. You can capture new images and videos using IA Album’s Camera mode, or get
images and video files from received E-mail, a Storage Card, infrared beaming, or syn-
chronised from a PC. The JPEG, BMP, GIF (both still and animated), WAV (audio), and
Motion-JPEG AVI (QuickTime video) file types are supported. You can switch to any
folder to browse for the supported image, video, and audio files, with an option to also
scan subfolders of the current folder.
If image/video/audio files are found, they can be displayed/played using three different
view modes: Thumbnail view, Detailed view, and Slide Show view.

Thumbnail view
You can display thumbnails in several different combinations of size, orientation, and
background colour, with or without the “info Pane“ under the thumbnails which displays
the file name, type, size, and dimensions of the currently selected file. (If a video file,
the total time of the video is also shown.) To control all of these options, select
Options>Thumbnails and Colours from the menu.
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Note: The total number of image/video files found in the current folder is displayed in 
the Title Bar, and the current folder is shown directly under the Title Bar.

Detailed view
Detailed view mode utilises the whole screen to display still images or to play back and
animated GIF files. When you press the Action button during Thumbnail View mode (or
select View/Play from the menu), Detailed View mode is launched and the selected
thumbnail will be enlarged in the display area.You can also enter Detailed View mode
by selecting View Captured from the menu when in Camera mode.
Press the Action button to toggle between the Zoom submode and the Pan submode,
or use Zoom/Pan on the main menu. You can also display images in Actual Size. When
in Zoom mode, press the Up and Down buttons on your Smartphone to Zoom In or Out,
and press Left/Right to display the previous/next file. If the image/video is too large to
display on the screen in its entirety, Pan submode allows you to move it in any of four
directions in the display area. A box in the lower left corner will indicate the position of
the displayed portion in relation to the total size. Press the direction keys to pan.
AVI video files, animated GIF files, and WAV audio files can be set to play only once, or
to antomatically play over repeatedly, or can be manually Played/Paused by pressing
the 7 key. A Progress Bar keeps you informed of the playback progress. (In the right-

Large thumbnails
with infor Pane

Portrait thumbnails List View
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most figure below, only one second of the video has played thus far.) Video files can
also be converted into animated GIF files for greater portability.

If you have IA Caller ID, you can select Send to IA Caller ID on the Send submenu to
invoke the IA Caller ID application and assign the selected photo to one of your Pocket
Contacts. It will then be used as a Photo ID when you receive an incoming call from that
person. You can also send image/video/audio files via MMS (if a compatible version has
been installed), E-mail, and Infrared beaming.
You can set any image to be your Smartphone’s Home screen. First, arrange it any way
you want using Zoom, Pan, Rotate, Flip, Fit to Window, etc. Then select Set Home
Screen from the menu. If you ever want to reset the Home screen to the Smartphone’s
original default image, select Reset Home Screen from the File submenu.

Slide show view
When in Detailed View mode or Thumbnail View mode, choose Slide Show from the
menu, or simply press the 0 key, to start a slide show. When Slide Show mode is initially
invoked, each image, video, and audio file in the current folder will be displayed auto-
matically, with the Title Bar and Softkey Labels displayed. If video or WAV audio files
are encountered, they will be played once during the slide show.

Zoom submode of
Detailed View

Pan submode
after zoom and

Video playback in
progress
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At any time during the Slide Show playback, press 6 to toggle the Full Screen display
on or off. (Or, select Full Screen from the menu to switch it on/off.) When Full Screen is
“On“, the Title Bar and Softkey labels will not be displayed on the screen during the
Slide Show.

You can customise the behavior of your slide shows by specifying a rule for rotation, the
amount of time to pause between image changes, transition effects/speed, and even
the “play order“ (forward, backward, or random). To do so, select Slide Show Options
from the menu.

For more information, contact us at:
Web site: http://www.iastyle.com

Slide Show in Slide Show in Full Main menu
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Product support:supportE@iastyle.com

Microsoft® and Windows® are trademarks or registered trademarks of Microsoft Corpo-
ration in the United States and/or other countries.
IA Album™, IA Capture™, and Information In Action™ are trademarks of IA Style, Inc.
The names of other actual companies, products and brand names mentioned herein
may be trade names, service marks, trademarks, or registered trademarks of their
respective owners. The illustrations that appear in this document may differ slightly from
the screens that actually appear when you operate the product. All names, phone num-
bers, and e-mail addresses shown in the example are fictional, and any similarity to
actual names, people, telephone numbers, e-mail addresses, and other data is purely
coincidental.
The IA Album programs are Copyright  2000-2003 by IA Style, Inc. and all rights are
reserved. Reproduction, adaptation, or translation of these programs and accompany-
ing documentation without prior written permission from IA Style, Inc. is prohibited.

Using IA File Manger
IA File Manager is for file and folder management in your Smartphone. It operates in
two major views, Tree view and List view.
• Tree View displays the entire file structure in the Smartphone's memory. The functions

in Tree View primarily focus on folder management (operates similar to Microsoft Win-
dows File Explorer).

• List View displays the details of the selected folder (its sub-folders and files). The func-
tions in List View are basically file-oriented.

Installing and Stating IA File Manager
If you are installing IA File Manager from a Companion CD, follow the instructions on
your computer screen and your Smartphone screen. IF you are installing from a Stor-
age Card, follow the instructions on your Smartphone screen. We strongly recommand
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that you install IA File Manager to the main unit (Smartphone's local "Phone" storage).
After installing, select File Manager from your Smartphone's Programs menu to start it.

Key Features:
• Send the selected files via E-mail or Infrared beaming, and receive files via infrared

beaming
• Delete, move, or copy/paste folders and files
• Search for files according to portions of filenames and/or text contained in the files
• View file or folder properties
• View information about memory utilisation, device, storage card, and battery power
• Sort listed files in a variety of ways (by name, size, date, type; ascending or descend-

ing)
• Set viewing options such as font size, whether to hide file extensions, etc.
• Create file shortcuts
• Associate specific filetypes to start with specific applications when selected

When IA File Manager is initially invoked, it is in Tree View by default. To switch to List
View, press the Left soft key. If the currently selected folder contains no subfolders,

Tree View List View
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pressing the Action button will also switch to List View. If the selected folder in Tree
View does contain subfolders, pressing Action button expands or collapses the tree for
that folder. For most functions, you must first select the file or folder you wish to operate
on, the select the desired command from the menus, or press the shortcut key on your
Smartphone keypad, if a shortcut exists.

For more information, contact us at:
Web site: http://www.iastyle.com
Product support: supportE@iastyle.com

Microsoft® and Windows® Powered Smartphone are trademarks or registered trade-
marks of Microsoft Corporation in the United States and/or other countries.
IA File Manager™ and Information in Action™ are trademarks of IA Style, Inc.
The names of other actual companies, products and brand names mentioned herein
may be trade names, service marks, trademarks, or registered trademarks of their
respective owners.
The IA File Manager programs are Copyright  2000-2003 by IA Style, Inc. and all
rights are reserved. Reproduction, adaptation, or translation of these programs and
accompanying documentation without prior written permission from IA Style, Inc. is pro-
hibited.

jMMS
The Jataayu MMS Client facilitates the transmission of multimedia content (text, audio,
and image) to any MMS enabled client. The Jataayu MMS Client is also referred to as
jMMS.
The main objectives of the jMMS is to provide: A better user interface for the exchange
of MMS messages via WAP WAP-HTTP communication.
jMMS provides a rich user interface for composing SMIL pages. jMMS has been built
over WAP and 3GPP specifications, and is interoperable with the existing MMSC.
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jMMS also facilitates the exchange of multimedia messages with the existing MMS Cli-
ent.

Features

Receiving MMS messages
jMMS supports the receipt of multimedia notification for incoming messages, over SMS.
The incoming message notification is stored in the Inbox folder .

Sending MMS messages
Using the jMMS, multimedia messages can be sent as MMS SMIL content.
The user has the following options to send the SMIL content:
Image and text
Audio and text
Audio, text and image

Sending SMS messages
The user can send the text only as SMS instead of sending it as MMS.

Address book
The recipient’s addresses can be inserted from the address book while sending a mes-
sage.

Configuration of multiple MMSCs
Multiple MMSCs can be configured with different originator addresses. Any one of
these addresses can be activated for establishing a connection.
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System requirements

Hardware
Smart-Phone 2002 with ARM processor
Minimum memory of 1 MB

Software
Microsoft powered Smartphone 2002

For more information
All your queries can be addressed to: helpdesk@jataayusoft.com

Getting to know jMMS
The Integrated inbox will be invoked from the “Programs” options.
The dpad direction buttons can be used for navigation, and the dpad action button can
be used for selection.
Select Menu to access the relevant options, Select to choose the highlighted item, and
View to view the selected item.
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New
Clicking on New soft key will display the blank screen with the Menu to add the con-
tents, which is shown in the second slide. The Send soft key helps the user to send the
MM.

Insert
The Insert option helps you to insert the Pictures,Text, and Audio to your MM.
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Picture
To insert picture to your MM select Menu->Insert->Picture. The screen with the
images is displayed. You can choose the image by clicking on the Select soft key. The
Menu option helps you to perform various operations on the images displayed.

Cancel
This option helps you to cancel the image selection and return to the compose screen.
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More
This option is enabled only if you have more than 9 images.

Delete
Delete option helps you to delete the selected image. An Alert message is displayed
before deleting the image. Clicking on Yes soft key will delete the selected image.
Clicking on No will cancel the deletion operation.
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Properties
This option helps the user to view the property of the selected image.

On inserting the image to your MM click on Send soft key to send the MM.

Send MMS
You get the Send MMS screen. Enter the valid mobile number in theTo text box.You
can send this message to multiple recipients by adding their mobile numbers in CC and
BCC fields. You can add the subject to your message by filling in the Subject field. Once
you start sending the message the processing is shown to you. Click on Stop soft key
to stop the sending of the message.
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To select an address from the phone book, press Phone Book. This displays the phone
book from which the user can select the required address. The Address Book contains
the Name, Email or Mobile numbers of the contact.
Note:  Phone Book cannot be edited. To add an address to the phone book, click Con-
tacts from the main screen of the device, click New and add a contact.

You can view either the Name with corresponding phone number or the names with the
Email ID.
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Text
To insert the text to your MM go to Menu-> Insert-> Text option. You get a page where
you can type your message. Click on Save soft key to save the message. Click on Can-
cel to cancel the message.

You can send the message by clicking on Send soft key. If the message contains only
text then you get a notification asking if you want the message to be sent as SMS. Click
on Yes to send as SMS. Click on No to send it as MMS.
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Audio
To insert the audio to your MM go to Menu->Insert->Audio option. The list of audio
files is displayed. Click on Select soft key to select the audio file.

On selecting the audio file an audio icon is displayed in your MM page. Click on Send
soft key to send the MM.
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Remove
To remove the picture from the MM this option is used. Menu->Remove->Picture.
To remove the inserted text go to Menu->Remove->Text.

To remove the audio from the MM this option is used. Menu->Remove->Audio.
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Preview
This option helps you to view the composed MMs.
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Slide
This option helps you to Insert and Delete slides with options for navigating between
different slides.

Add
This option helps you to add a new slide to the message.
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Delete
To delete a slide you can use this option.

Next and previous
To navigate between slides you can either use Next or Previous option.
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Background
This option helps you change the background colour of your message. On selecting this
option you will get a set of colours from which you can choose.

The following screen shows the changed Background colour of the message.

Camera
Camera Option allows capturing image using the camera attached to the Device. Then
the image can be sent. Selecting the option Camera will take you to the Capture Image
page where the contents can be captured. Once the image is captured using Capture
option you get a still image.
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Send message
This option helps you to send the message.

Cancel message
To cancel the composed message you can select Cancel message.
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Network Configuration

Jataayu MMS Client Connection Profiles
jMMS supports multiple connection profiles. Select any of the given profiles and edit the
content to suit the available network setup.
• WAP 1.0 Gateway (Over WAP 1.x compliant gateway)
• WAP 2.0 Gateway (Over WAP 2.x compliant gateway)
• None (Direct Http)

To configure WAP 1.0 Gateway
In the Edit Profile screen:
1. Select Profile, and enter a name.
2. Select Gateway.
3. The Gateway Select screen is displayed. Select WAP 1.0 Gateway from the list.
4. Select MMS, and enter the URL.
5. Select Address and enter the address for the WAP 1.x gateway.
6. Select Port and enter the port number.
7. Select User and enter a name.
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8. Select Address and enter the address.

To configure WAP 2.0 Gateway
In the Edit Profile screen:
1. Select Profile, and enter a name
2. Select Gateway.
3. The Gateway Select screen is displayed. Select WAP 2.0 Gateway from the list.
4. Select MMS, and enter the URL.
5. Select Address and enter the address for the WAP 2.0 gateway.
6. Select Port and enter the port number.
7. Select User and enter a name.
8. Select Address and enter the address.

To configure for none (Http)
In the Edit Profile screen:
1. Select Profile, and enter a name
2. Select Gateway.
3. The Gateway Select screen is displayed. Select None from the list.
4. Select MMS, and enter the URL.
5. Select User and enter a name.
6. Select Address and enter the address.
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Solitaire
The object of Solitaire is to use all the cards in the deck to build up the four suit stacks
in ascending order, beginning with the aces.You win the game when all cards are on
the suit stacks.

To start a game of Solitaire
• On the Home screen, press the Programs soft key, select More, select Games,

select Solitaire, and then press the Action button.

Playing Solitaire

To start a new game of Solitaire
• In Solitaire, press the Menu soft key, and then select New Game.

To move cards in Solitaire
• Press the number or character above the card stack displaying the card you want to

move, and then press the number or character above the card stack to which you
want to move the card.
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Note: Pressing Up will move a card to one of the four card stacks on the upper right 
corner of the screen if it belongs there. For example, if you have an ace displayed in 
one of the seven stacks, press the number above the ace, and then press Up.

To play Solitaire
1. Move any aces on the seven stacks to the four card spaces at the top of the screen,

and then make any other available plays.
2. When you have made all available plays, press the Draw soft key to turn over cards.
Note: The card that is face up on the deck is always available for play. 

Calculator
You can use Calculator to perform any of the standard operations for which you would
normally use a hand-held calculator. Calculator performs basic arithmetic, such as addi-
tion, subtraction, multiplication, and division.

To open Calculator
• On the Home screen, press the Programs soft key, select More, select Accessories,

select Calculator, and then press the Action button.

To enter numbers and perform calculations
• Use the keypad to enter numbers and perform calculations.
• Press the Pound (#) key to cycle through the available mathematical symbols, and

press the Asterisk (*) key to enter a decimal point.
Note: You can also use the direction keys to display the available mathematical sym-
bols. Press Up for the plus sign (+), press Down for the minus sign (-), press Left for the 
division sign (/), and press Right for the multiplication sign (X).

To clear the current calculation or displayed number
• Press the Clear soft key.
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To clear the last digit entered in a multiple-digit entry 
• Press the Back button.
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Care and Maintenance
It is recommended that you observe the cautions below to prevent possible damage to
your phone and to keep your phone in good condition.

When using your phone
• Avoid using your phone in dusty, extremely high or low temperature environments.
• Your phone does not provide water-proof capability. Do not spill water onto the phone

or use it in the water or rain.
• Avoid removing the battery without turning off the phone in advance. If you want to

remove the battery, turn phone power off first.
• Do not apply strong force or shock to the phone.
• Keep the phone and its accessories away from small children.
• Do not insert metal objects into the battery charger socket of the phone. This can

short-circuit the battery and result in danger.
• Back up your Phone Book data regularly onto the SIM card.

When cleaning your phone
• Use soft, clean and slightly moistened cloth to clean your phone. Do not let water

come into any openings (such as earphone and microphone) or remain on metal
surface (such as the metal contacts).

• Do not wipe your phone with any corrosive liquid or coarse objects. This can damage
the outer case of your phone.

When carrying/storing your phone
• Do not leave your phone in hot enclosed places (such as in a car under direct

sunlight).
• Avoid pressing and shaking the phone when you carry it.
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• Remove the battery from phone if it is not going to be used for a long period of time.
Keep the phone and battery in a cool and dry place.

When using the accessories
• Use only approved batteries and accessories. Use of non-approved accessories can

cause damage to your phone or yourself.
• Do not use the battery and charger for other purposes.

When using your phone in public areas
Use the phone with manner. Turn it off or make it silent when you are asked to.

When the phone appears to be broken
Do not attempt to disassemble/fix the phone by yourself. Seek your original dealer for
help.
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Troubleshooting
If problems occur when you use your phone, please refer to the table below to find out
possible solutions. If your problem is not in the table, or the problem still persists after
you try these solutions, please seek your original dealer for help.

When you encounter these
problems...

Please check...

Can not turn on the phone

• Is the battery empty?

• Is the battery properly installed?

• Are the contacts on battery and phone clean? If
the contacts appear to be soiled, contact your
dealer to clean them.
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Unable to make calls.

• Is the reception of network signal in good
condition? Move to an open space, or a place
closer to window.

• Is network selection setting setup properly? If
necessary, try to select your network manually.

• Have you already activated the fixed dialling and
call barring functions? If yes, deactivate them
temporarily.

• Has the call cost exceeded your cost credit?
Check your remaining cost credit and reset the
call cost if necessary.

• Are you using your phone with other SIM cards
when SIM lock protection function has been
activated? Deactivate the function if necessary.

Unable to receive calls.

• Is the reception of network signal in good
condition? Move to an open space, or a place
closer to window.

• Have you already activated call divert or call
barring functions? Deactivate them if necessary.

Your voice can not be heard.
Have you already turned on the in-call mute
function? Turn it off if necessary.

Can not use certain call
functions.

To use certain advanced call functions (such as
call divert and call barring), you may need to
subscribe these services to your operator first.



Troubleshooting - 155

There are noises during a phone
call.

Avoid using the phone near a microwave oven,
speaker or TV. Their interference has adverse
effect to call quality.

Can not connect to the Internet

• Have you subscribed the Internet (WAP) service
to your operator?

• Did you enter correct setting parameters (such
as APN and IP addresses) in WAP profile setup?

The screen shows "Insert SIM".

• Is your SIM card correctly inserted into the
phone?

• Are the metal contacts on SIM card clean? If they
appear to be soiled, please contact your dealer
to clean them.

The battery can not be charged.

• Is the battery charger correctly plugged into the
battery charger socket on the phone?

• Is the power cord of the charger damaged?

• Is the battery very old? Replace with a new
battery and try again.
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The standby and talk time is
apparently shorter than ever.

• Your phone consumes more power when signal
reception is poor. Try to move to a better location
when you use the phone.

• Are you using a new battery? It takes several
charge discharge cycles for the battery to reach
its original capacity.

• Is the battery very old? Replace it with a new
one.

• Are you using the phone in very high or low
temperature environment? The efficiency of a
battery can be effected by ambient temperature.

Can not deactivate call barring or
call divert functions.

Is the reception of network signal in good
condition? Move to an open space, or a place
closer to window.
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Specific Absorption Rate Data

The model phone meets the government’s requirements for exposure to radio
waves.
Your mobile phone is a radio transmitter and receiver. It is designed and manufactured
not to exceed limits for exposure to radio frequency (RF) energy. These limits are part
of comprehensive guidelines and establish permitted levels of RF energy for the gen-
eral population. The guidelines are based on standards that were developed by inde-
pendent scientific organizations through periodic and thorough evaluation of scientific
studies. The guidelines include a substantial safety margin designed to assure the
safety of all persons, regardless of age and health.
The exposure standard for mobile phones employs a unit of measurement known as
the Specific Absorption Rate, or SAR. Under the guidelines for your phone model, the
SAR limit is 1.6 W/kg.1 Tests for SAR are conducted using standard operating positions
with the phone transmitting at its highest certified power level in all tested frequency
bands. Although the SAR is determined at the highest certified power level, the actual
SAR of the phone while operating can be well below the maximum value. This is
because the phone is designed to operate at multiple power levels so as to use only the
power required to reach the network. In general, the closer you are to a base station,
the lower the power output of the phone.
Before a phone model is available for sale to the public, it is tested to confirm compli-
ance with the guidelines. The tests are performed in positions that conform to a uniform
testing methodology determined by an expert standards body. The highest SAR value
for this model phone when tested for use at the ear is ____ W/kg.2

While there may be differences between the SAR levels of various phones and at vari-
ous positions, they all meet the governmental requirements for safe exposure. Please
note that improvements to this product model could cause differences in the SAR value
for later products; in all cases, products are designed to be within the guidelines.
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• The SAR limit for mobile phones used by the public is 1.6 watts/kilogram (W/kg)
averaged over one gram of body tissue. The standard incorporates a substantial
margin of safety to give additional protection for the public and to account for any
variations in measurements.

• Additional related information includes the Motorola testing protocol, assessment
procedure, and measurement uncertainty range for this product.
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H
Handstrap hole 25
Headset socket 24
Home Screen
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